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Emulation for the PowerPC MPC500—At a Glance

Motorola’s embedded PowerPC MPC500 microprocessors provide a 
development port (also known as a debug port) that lets tools like the 
HP E3456A emulation probe or the HP 16610A emulation module give 
you capabilities like:

• Stopping or starting program execution.

• Setting breakpoints in the program.

• Displaying and modifying the contents of microprocessor registers.

• Displaying and modifying the contents of target system memory or I/O.

• Downloading program code to target system memory.

The HP E3456A emulation probe and the HP 16610A emulation 
module require that a debug port connector be designed into your 
target system (unless you have the HP E2490A analysis probe for 
MPC505/509 microprocessors which has a built-in connector for the 
emulation probe or emulation module).

Both the HP E3456A emulation probe and the HP 16610A emulation 
module come with a target interface module (TIM) that adapts the 
emulation probe or emulation module to a debug port connector in the 
target system.

The emulation probe or emulation module can be controlled by a 
debugger on a host computer or by the Emulation Control Interface on 
an HP 16600A/16700A-series logic analysis system.
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Emulation Probe

The HP E3456A emulation probe is a stand-alone unit that has its own 
power supply and local area network (LAN) interface.

The HP E3456A emulation probe is typically used in situations where 
only its capabilities are needed, for example, by software developers 
using debuggers to debug program code. But, it can also be used along 
with the HP 16600A/16700A-series logic analysis system when logic 
analysis capabilities are needed.

Emulation Module

The HP 16610A emulation module is designed to be installed in 
HP 16600A/16700A-series logic analysis systems. The logic analysis 
system supplies the power and LAN interface.

The HP 16610A emulation module is typically used in situations where 
its capabilities are needed along with the logic analysis system 
capabilities, for example, by hardware designers, firmware developers, 
and system integrators who are analyzing the real-time execution of a 
microprocessor-based target system.
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In This Book

This book describes the following products:

This book shows how to:

• Install and set up the emulation probe or emulation module.

• Connect the emulation probe/module to a target system.

• Configure the emulation probe/module for proper operation with your 
target system.

• Use the emulation probe/module with debuggers.

This book also describes the specifications and characteristics of the 
emulation probe/module, and it contains service information.

See Also If you’re using the Emulation Control Interface in the HP 16600A/
16700A-series logic analysis system to control the emulation probe/
module, see the logic analysis system’s on-line help.

If you’re using a high-level source debugger to control the emulation 
probe/module, see the debugger’s documentation.

See also Hewlett-Packard’s logic analysis and emulation web site at:

http://www.hp.com/go/emulator

Comments on the 
Documentation?

Send email to documentation@col.hp.com (for comments only; 
please contact your local HP representative if you need technical 
support).
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Chapter 1: Installing the Emulation Probe
Overview of Installation and Setup
Overview of Installation and Setup

Follow these steps to connect your equipment.

1 Check that you received all of the necessary equipment. See 
“Equipment and Requirements” on page 16.

2 Disconnect power from the target system, emulation probe, and 
logic analyzer before you make or break connections. See 
“Powering-On and Powering-Off the Emulation Probe” on 
page 19.

3 Connect the emulation probe to a LAN. See “Connecting the 
Emulation Probe to a LAN” on page 21.

4 Update the emulation probe’s firmware to give it the proper 
“personality” for the microprocessor it will connect to. See 
“Updating Emulation Probe Firmware” on page 40.

5 Connect the emulation probe to your target system. See the 
“Connecting to a Target System” chapter on page 63.

6 Configure the emulation probe. See the “Configuring the 
Emulation Probe/Module” chapter on page 75.
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Chapter 1: Installing the Emulation Probe
Overview of Installation and Setup
Emulation probe
HP E5900A

Connect power supply

Connect to LAN

Update emulation probe
firmware (if necessary)

Installation done. Begin
using emulation probe.

Connect emulation probe

Connect emulation probe
to target interface

module

Connect target interface
module to target
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Chapter 1: Installing the Emulation Probe
Equipment and Requirements
Equipment and Requirements

Listed below are:

• Equipment and software supplied with the emulation probe.

• Additional equipment and software required by the emulation probe.

Supplied Equipment and Software

The emulation probe includes:

• An emulation probe.

• A 12V power supply for the emulation probe.

• A power cord.

• A target interface module (TIM) circuit board.

The target interface module (TIM) is used to connect the emulation probe 
to a debug port connector in the target system.

The target interface module (TIM) is not needed when using the 
HP E2490A analysis probe for MPC505/509 microprocessors because the 
target interface module’s functionality is already built into the analysis 
probe.

• A 50-pin ribbon cable for connecting the emulation module to the target 
interface module (TIM) (or to the HP E2490A analysis probe).

• A 10-pin ribbon cable for connecting the target interface module (TIM) to 
a debug port connector in the target system.

• Emulation Control Interface software.

• An emulation probe loopback test board (HP part number E3496-66502).

• This User’s Guide.
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Chapter 1: Installing the Emulation Probe
Equipment and Requirements
Additional Equipment and Software Required

The emulation probe requires:

• A target system with the appropriate debug port connector. The target 
system must meet the criteria described in “Designing the Target System 
for an Emulation Probe/Module” on page 64.

• A local area network (LAN) for communicating with the emulation probe. 
The emulation probe needs to be assigned an internet (IP) address, and it 
needs to know the IP address of the gateway machine.

• Interface software that gives you access to the emulation probe’s 
functionality.

You can use a third-party high-level source debugger to access and control 
the emulation module. Debuggers can run on PC or UNIX workstations 
that are also on the local area network (LAN).

Or, you can use the HP 16600A/16700A-series logic analysis system’ s 
Emulation Control Interface.
17
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Equipment and Requirements
Other Optional Equipment

You can also use the emulation probe with:

• The HP 16600A/16700A-series logic analysis system.

• The HP E2490A analysis probe for Motorola Embedded PowerPC MPC505/
509 microprocessors.

The analysis probe captures microprocessor signals for logic analysis. The 
HP E2490A analysis probe has a built-in target interface module, which 
makes it unnecessary to design a debug port connector into the target 
system.
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Chapter 1: Installing the Emulation Probe
Powering-On and Powering-Off the Emulation Probe
Powering-On and Powering-Off the Emulation 
Probe

It’s important to follow the proper power-on or power-off sequences so 
that your target system, the emulation probe, and other equipment are 
not damaged.

To power on the system

With all components connected, power-on your system as follows:

1 Power-on the logic analyzer, if you are using one.

2 Power-on the emulation probe.

3 Power-on your target system.

To power off the system

Power off your system as follows:

1 Power-off your target system.

2 Power-off the emulation probe.

3 Power-off the logic analyzer, if you are using one.

To connect the emulation probe to a power 
source 

The emulation probe does not have an On/Off switch. To power on the 
emulation probe:

1 Connect the power cord to the power supply and to a socket 
19



Chapter 1: Installing the Emulation Probe
Powering-On and Powering-Off the Emulation Probe
outlet.

2 Connect the 12V power cord to the back of the emulation probe.

The power light on the target side of the emulation probe will be 
illuminated.

The emulation probe is shipped from the factory with a power supply 
and cord appropriate for your country. If the cord you received is not 
appropriate for your electrical power outlet type, contact your Hewlett-
Packard sales and service office.

WARNING: Use only the supplied HP power supply and cord. Failure to use the proper 
power supply could result in electric shock.

CAUTION: Use only the supplied HP power supply and cord. Failure to use the proper 
power supply could result in equipment damage.
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Chapter 1: Installing the Emulation Probe
Connecting the Emulation Probe to a LAN
Connecting the Emulation Probe to a LAN

The emulation probe communicates with a debugger (running on a PC 
or UNIX workstation), or with the HP 16600A/16700A-series logic 
analysis system, via a local area network (LAN). So, the first thing to do 
when installing an emulation probe is to set its LAN parameters.

There are two ways to set the emulation probe’s LAN parameters:

• By connecting an ASCII terminal (or a PC or UNIX workstation running 
terminal emulation software) to the emulation probe’s serial port and by 
using the emulation probe’s built-in terminal interface. This is the most 
reliable method.

(This type of connection is also used when running the complete set of 
emulation probe performance verification tests. Other use of the serial 
port and the terminal interface is not supported.)

• By using a BOOTP server running on the LAN. BOOTP is part of the 
HP-UX, SunOS, and Solaris operating systems.

What type of LAN connection must I use?

The emulation probe has two LAN connectors:

• A BNC connector that can be directly connected to an IEEE 802.3 Type 
10BASE2 cable (ThinLAN). When using this connector, the emulation 
probe provides the functional equivalent of a Medium Attachment Unit 
(MAU) for ThinLAN.

• An IEEE 802.3 Type 10BASE-T (StarLAN) connector. 

NOTE: Use either the 10BASE2 or the 10BASE-T connector. Do not use both. The 
emulation probe will not work with both connected at the same time.

What are LAN parameters?

You must assign an IP address (Internet address) to the emulation 
probe before it can operate on the LAN. You also set the gateway 
address. (The emulation probe automatically sets a subnet mask based 
on the subnet mask used by other devices on the network.)
21



Chapter 1: Installing the Emulation Probe
Connecting the Emulation Probe to a LAN
The IP address and other network parameters are stored in nonvolatile 
memory within the emulation probe.

To get the IP and gateway addresses

1 Obtain the following information from your local network 
administrator or system administrator:

• An IP address for the emulation probe.

You can also use a “hostname” for the emulation probe, but you must 
configure it using the integer dot notation (such as 127.0.0.1).

• The gateway address. 

The gateway address is an IP address and is entered in integer dot 
notation. The default gateway address is 0.0.0.0, which allows all 
connections on the local network or subnet. If connections are to be made 
to workstations on other networks or subnets, this address must be set to 
the address of the gateway machine. 

2 Find out whether port numbers 6470 and 6471 are already in use 
on your network and if that use constitutes a conflict.

The host computer interfaces communicate with the emulation probe 
through two TCP service ports. The default base port number is 6470. 
The second port has the next higher number (default 6471). 

In almost all cases, the default numbers (6470, 6471) can be used 
without change. If necessary, the default numbers can be changed if 
they conflict with some other product on your network. 

To change the port numbers, see “To configure LAN parameters using 
the built-in terminal interface” on page 23.

If you have already set the IP address and connected the emulation 
probe to the LAN, you can use a telnet connection instead of a serial 
connection to connect to the emulation probe.

3 Write down the link-level address of the emulation probe.

You will need this address if you use BOOTP to set the IP address.
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Chapter 1: Installing the Emulation Probe
Connecting the Emulation Probe to a LAN
The link-level address (LLA) is printed on a label above the LAN 
connectors on the emulation probe. This address is configured in each 
emulation probe shipped from the factory and cannot be changed.

IP Address of Emulation Probe __________________________

Hostname of Emulation Probe __________________________

Gateway Address __________________________

Link-Level Address of Emulation Probe __________________________

To configure LAN parameters using the built-in 
terminal interface 

1 Set configuration switches S1 through S4 to ON, and set the 
other switches as appropriate for your serial interface.

Switch setting definitions are printed on the bottom of the emulation 
probe. If you will use a baud rate of 9600 baud, set the switches like 
this:

2 Connect an ASCII terminal (or terminal emulator) to the 
emulation probe’s RS-232 port with a 9-pin RS-232 cable.

Complete instructions for setting up a serial connection can be found in 
“Connecting a Terminal to the Emulation Probe’s Serial Port” on 
page 34.

3 Plug in the emulation probe’s power cord. Press the terminal’s 
Enter (that is, carriage return) key a couple times. You should 
see a prompt such as “p>”, “?>”, or “R>”.

At this point, you are communicating with the emulation probe’s built-
23
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Connecting the Emulation Probe to a LAN
in terminal interface.

4 Display the current LAN configuration values by entering the lan 
command:

R>lan
lan is disabled 
lan -i 0.0.0.0 
lan -g 0.0.0.0 
lan -p 6470 
Ethernet Address : 08000903212f

The “lan -i” line shows the current IP address (IP address) of the 
emulation probe.

The Ethernet address, also known as the link-level address, is 
preassigned at the factory, and is printed on a label above the LAN 
connectors.

5 Enter the following command:

lan -i <internet> [-g <gateway>] [-p <port>]

The lan command parameters are:

The IP address and any other LAN parameters you change are stored 
in nonvolatile memory and will take effect the next time the emulation 
probe is powered off and back on again.

-i <internet> The IP address which you obtained from your network 
administrator.

-g <gateway> The gateway address. Setting the gateway address allows 
access outside your local network or subnet.

-p <port> This changes the base TCP service port number.

The default numbers (6470, 6471) can be changed if they 
conflict with some other product on your network. TCP 
service port numbers must be greater than 1024. If you 
change the base port, the new value must also be entered 
in the /etc/services file on the host computer. For example, 
you could modify the line:

hp64700    6470/tcp
24  



Chapter 1: Installing the Emulation Probe
Connecting the Emulation Probe to a LAN
6 Disconnect the power cord from the emulation probe, and 
connect the emulation probe to your network.

This connection can be made by using either the 10BASE-T connector 
or the 10BASE2 (BNC) connector on the emulation probe. Do not use 
both connectors at the same time.

7 Set the configuration switches to indicate the type of connection 
that is to be made.

Switch S1 must be set to OFF, indicating that a LAN connection is 
being made.

Switch S5 should be ON if you are connecting to the BNC connector:

Switch S5 should be OFF if you are connecting to the 10BASE-T 
connector:

If you are using the 10BASE-T connector, see “To set the 10BASE-T 
configuration switches” on page 28.

Set all other switches to ON.

8 Connect the power cord to the emulation probe.

9 Verify your emulation probe is now active and on the network. 
See “To verify LAN communications” on page 29.

Once you have set a valid IP address, you can use the telnet utility to 
connect to the emulation probe, and use the lan command to change 
LAN parameters.
25
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Example To assign an IP address of 192.6.94.2 to the emulation probe, enter the 
following command:

R>lan -i 192.6.94.2 

Now, cycle power on the emulation probe so that the new address will 
take effect.

See Also If you have problems verifying LAN communication, see “Solving LAN 
Communication Problems” on page 31.

To configure LAN parameters using BOOTP

Use this method only on a workstation which is running bootpd, the 
BOOTP daemon. 

1 Make sure that BOOTP is enabled on your host computer.

If the following commands yield the results shown below, the BOOTP 
protocol is enabled:

$ grep bootp /etc/services 
bootps 67/udp 
bootpc 68/udp
$ grep bootp /etc/inetd.conf 
bootps  dgram  udp  wait    root  /etc/bootpd   bootpd

If the commands did not yield the results shown, you must either add 
BOOTP support to your workstation or use a different method to 
configure the emulation probe LAN parameters.

2 Add an entry to the host BOOTP database file, /etc/bootptab. For 
example:

# Global template for options common to all HP64700
# emulators and Emulation Probes.
# Use a different gateway addresses if necessary.
hp64700.global:\

:gw=0.0.0.0:\
:vm=auto:\
:hn:\
:bs=auto:\
:ht=ether
26  



Chapter 1: Installing the Emulation Probe
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# Specific emulator entry specifying hardware address
# (link-level address) and ip address.
hpprobe.div.hp.com:\

:tc=hp64700.global:\
:ha=080009090B0E:\
:ip=192.6.29.31

In this example, the “ha=080009090B0E” identifies the link-level 
address of the emulation probe. The “ip=192.6.29.31” specifies the IP 
address that is assigned to the emulation probe. The node name is 
“hpprobe.div.hp.com”. 

3 Connect the emulation probe to your network. 

This connection can be made by using either LAN connector on the 
emulation probe.

4 Set the configuration switches to indicate the type of connection 
that is to be made.

Switch S1 must be set to OFF, indicating that a LAN connection is 
being made.

Switch S6 must be set to OFF to enable BOOTP mode.

Switch S5 should be set to OFF if you are connecting to the BNC 
connector.

Switch S5 should be set to ON if you are connecting to the 10BASE-T 
connector.

If you are using the 10BASE-T connector, see “To set the 10BASE-T 
27
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configuration switches” on page 28.

Set all other switches to ON.

5 Connect the power cord to the emulation probe.

6 Verify that the power light stays on after 10 seconds.

The IP address will be stored in EEPROM.

7 Set switch S6 back to ON. 

Do this so that the emulation probe does not request its IP address 
each time power is cycled. The IP address is stored in EEPROM, so 
BOOTP does not need to be run again. Leaving this switch on will 
result in slower performance, increased LAN traffic, and even failure to 
power up (if the BOOTP server becomes inactive).

8 Verify your emulation probe is now active and on the network. 
See “To verify LAN communications” on page 29.

See Also For additional information about using bootpd, refer to the bootpd(1M) 
man page.

To set the 10BASE-T configuration switches

Set switches S7 and S8 to ON unless one of the following conditions is 
true:

• If the LAN cable exceeds the standard length, set switch S7 to OFF.

The emulation probe has a switch-selectable, twisted-pair receiver 
threshold. With switch S7 set to OFF, the twisted-pair receiver threshold is 
lowered by 4.5 dB. This should allow you to use cable lengths of up to 
about 200 meters. If you use a long cable, you should consult with your 
LAN cabling installer to ensure that:

• The device at the other end of the cable has long cable capability, and

• The cable is high-grade, low-crosstalk cable with crosstalk attenuation 
of greater than 27.5 dB.
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When switch S7 is set to ON, the LAN port operates at standard 10BASE-T 
levels. A maximum of 100 meters of UTP cable can be used.

• If your network doesn’t support Link Beat integrity checking or if the 
emulation probe is connected to a non 10BASE-T network (such as 
StarLAN) set this switch to LINK BEAT OFF (0 or OPEN).

In normal mode (switch S8 set to ON), a link integrity pulse is transmitted 
every 15 milliseconds in the absence of transmitted data. It expects to 
receive a similar pulse from the remote MAU. This is the standard link 
integrity test for 10BASE-T networks. If your network doesn’t support the 
Link Beat integrity checking or if the emulation probe is used on a non 
10BASE-T network (such as StarLAN) set this switch to LINK BEAT OFF 
(OFF).

NOTE: Setting switch S8 to OFF when Link Beat integrity checking is required by 
your network will cause the remote MAU to disable communications.

To verify LAN communications

1 Verify your emulation probe is now active and on the network by 
issuing a telnet to the IP address. 

This connection will give you access to the emulation probe’s built-in 
terminal interface. 

2 To view the LAN parameters, enter the lan command at the 
terminal interface prompt.

3 To exit from this telnet session, type Ctrl-d at the prompt.

The best way to change the emulation probe’s IP address, once it has 
already been set, is to telnet to the emulation probe and use the 
terminal interface lan command to make the change.

Remember, after making your changes, you must cycle power or enter 
a terminal interface init -p command before the changes take effect. 
Doing this will break the connection and end the telnet session.
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Example $ telnet 192.35.12.6
R>lan

lan is enabled
lan -i 192.35.12.6
lan -g 0.0.0.0
lan -p 6470
Ethernet Address : 08000F090B30

See Also If you encounter problems, see “Solving LAN Communication 
Problems” on page 31.
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Solving LAN Communication Problems

If you cannot verify LAN communication

If you cannot verify LAN communication using the procedure in “To 
verify LAN communications” on page 29, or if the commands are not 
accepted by the emulation probe:

❏ Make sure that you have connected the emulation probe to the 
proper power source and that the power light is lit.

❏ Make sure that you wait for the power-on self test to complete 
before connecting.

❏ Make sure that the LAN cable is connected. Watch the LAN 
LED’s to see whether the emulation probe is seeing LAN activity. 
Refer to your LAN documentation for testing connectivity.

❏ Make sure that only one of the LAN ports is connected.

❏ Make sure the emulation probe communication configuration 
switches are set correctly. Unplug the emulation probe power 
cord, then plug it in again to make sure the switch settings are 
read correctly by the emulation probe.

❏ Check that the Emulation Control Interface or debugger was 
configured with the correct LAN address. If the emulation probe 
is on a different subnet than the host computer, check that the 
gateway address is correct.

❏ Make sure that the emulation probe’s IP address is set up 
correctly. Use the RS-232 port to verify this that the IP address is 
set up correctly. When you are connected to the RS-232 port, run 
performance verification on the emulation probe’s LAN interface 
with the “pv” command.

❏ It’s also possible for there to be a problem with the emulation 
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probe firmware while the LAN interface is still up and running. In 
this case, you must reboot the emulation probe by disconnecting 
power to the emulation probe and reconnecting it again.

❏ Use a serial connection to run the LAN performance verification 
tests (see “To run complete performance verification tests for an 
emulation probe” on page 138).

If you have LAN connection problems

❏ If the emulation probe does not accept commands from the 
HP 16600A/16700A-series logic analysis system or a debugger:

1. Check that switch S1 is “0” (attached to LAN, not RS-232).

2. Check that switch S5 is in the correct position for your LAN interface 
(either 10BASE2 or 10BASE-T).

(Remember: if you change any switch settings, the changes do not take 
effect until you cycle power.)

❏ If the emulation probe still does not respond, you need to verify 
the IP address and gateway address settings of the emulation 
probe.

To do this, connect the emulation probe to a terminal or terminal 
emulator (see “Connecting a Terminal to the Emulation Probe’s Serial 
Port” on page 34), change the switch settings so it is connected to 
RS-232, and enter the “lan” command. The output looks something like 
this:

lan -i 15.5.24.116
lan -g 15.5.23.1
lan -p 6470
Ethernet Address : 08000909BAC1

“lan -i” shows the internet address is 15.5.24.116 in this case. If the 
Internet address (IP) is not what you expect, you can change it with 
the “lan -i <IP_address>” command.

“lan -g” shows the gateway address. Make sure it is the address of your 
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gateway if you are connecting from another subnet, or 0.0.0.0 if you are 
connecting from the local subnet.

“lan -p” shows the port is 6470.

If the “POL” LED is lit

The “POL” LED indicates that the polarity is reversed on the receive 
pair if you are using a 10BASE-T connection. The emulator should still 
work properly in this situation, but other LAN devices may not work.

If it takes a long time to connect to the network

❏ Check the subnet masks on the other LAN devices connected to 
your network. All of the devices should be configured to use the 
same subnet mask.

Subnet mask error messages do not indicate a major problem. You can 
continue using the emulation probe. 

The emulation probe automatically sets its subnet mask based on the 
first subnet mask it detects on the network. If it then detects other 
subnet masks, it will generate error messages.

If there are many subnet masks in use on the local subnet, the 
emulation probe may take a very long time to connect to the network 
after it is turned on.

To “clean up” the network, connect a terminal to the emulation probe. 
You can then see error messages which will help you identify which 
devices on the network are using the wrong subnet masks.
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Connecting a Terminal to the Emulation Probe’s 
Serial Port

To set up a serial connection, you will need to:

• Set the serial configuration switches.

• Connect a serial cable between the host computer and the emulation 
probe.

• Verify communications.

Serial connections on a workstation

If you are using a UNIX workstation as the host computer, you need to 
use a serial device file. If a serial device file does not already exist on 
your host, you need to create one. Once it exists, you need to ensure 
that it has the appropriate permissions so that you can access it. See 
the system documentation for your workstation for help with setting up 
a serial device.

Serial connections on a PC

Serial connections are supported on PCs. You must use hardware 
handshaking if you will use the serial connection for anything other 
than setting LAN parameters.

If you are using a PC as the host computer, you do not need to set up 
any special files.

To set the serial configuration switches 

1 Set switch S1 to ON (RS-232).

2 Set switches S2-S4 to ON.

3 Set switch S5 to ON (HW HANDSHAKE ON) if your serial 
interface uses the DSR:CTS/RTS lines for flow control. Set S5 to 
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OFF (HW HANDSHAKE OFF) if your serial interface uses 
software flow control (XON/XOFF).

If your serial interface supports hardware handshaking, you should use 
it (set switch S5 to ON). Hardware handshaking will make the serial 
connection much more reliable.

4 Set switches S6-S8 for the baud rate you will use. These switch 
settings are listed on the bottom of the emulation probe.

The higher baud rates may not work reliably with all hosts and user 
interfaces. Make sure the baud rate you choose is supported by your 
host and user interface.

Example To use a baud rate of 9600 baud, set the switches as follows:

To connect a serial cable

CAUTION: Use a grounded, shielded cable. If the cable is not shielded, or if the cable is 
not grounded at the serial controller, the emulation probe may be damaged by 
electrostatic discharge.

Connect an RS-232C modem cable from the host computer to the 
emulation probe. The recommended cable is HP part number C2932A. 
This is a 9-pin cable with one-to-one pin connections.

If you want to build your own RS-232 cable, follow the pinout shown in 
the following figure:
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To verify serial communications

1 Start a terminal emulator program on the host computer.

If you are using a PC, the Terminal application in MS Windows 3.1, or 
the HyperTerminal application in MS Windows 95/NT, will work fine.

If you are using a UNIX workstation, you can use a terminal emulator 
such as cu or kermit.

2 Plug the power cord into the emulation probe.

When the emulation probe powers up, it sends a message (similar to 
the one that follows) to the serial port and then displays a prompt:

6HULDO�&DEOH�3LQRXW

3LQ�1XPEHU 6LJQDO 6LJQDO�'HVFULSWLRQ

� '&' 'DWD�&DUULHU�'HWHFW��QRW�XVHG�

� 7' 7UDQVPLW�'DWD��GDWD�FRPLQJ�IURP�+3 HPXODWLRQ�SUREH�

� 5' 5HFHLYH�'DWD��GDWD�JRLQJ�WR�+3 HPXODWLRQ�SUREH�

� '75 'DWD�7HUPLQDO�5HDG\��QRW�XVHG�

� *1' 6LJQDO�*URXQG

� '65 'DWD�6HW�5HDG\��2XWSXW�IURP�+3 HPXODWLRQ�SUREH�

� 576 5HTXHVW�WR�6HQG��,QSXW�WR�+3 HPXODWLRQ�SUREH�

� &76 &OHDU�WR�6HQG��FRQQHFWHG�WR�SLQ���

� 5,1* 5LQJ�,QGLFDWRU��QRW�XVHG�
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Copyright (c) Hewlett-Packard Co. 1987
All Rights Reserved.  Reproduction, adaptation, or translation without
prior written permission is prohibited, except as allowed under
copyright laws.

HPE3499A Series Emulation System
Version:   A.07.53 01Mar98
Location:  Generics

HPE3459A ARM7 JTAG Emulator
Version:   A.01.01 01Mar98 

R>

The version numbers may be different for your emulation probe.

3 Press the Return or Enter key a few times.

You should see a prompt such as “p>”, “R>”, or “?>”.

For information about the commands you can use, enter ? or help at 
the prompt.

See Also If you encounter problems, see “Solving Serial Communication 
Problems” on page 38.
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Solving Serial Communication Problems

If you cannot verify RS-232 communication

If the emulation probe prompt does not appear in the terminal 
emulator window:

❏ Make sure that you have connected the emulation probe to the 
proper power source and that the power light is lit.

❏ Make sure that you have properly configured the data 
communications switches on the emulation probe and the data 
communications parameters on the host computer. You should 
also verify that you are using the correct cable.

The most common type of data communications configuration problem 
involves the configuration of the emulator as a DTE device instead of as 
a DCE device. If you are using the wrong type of cable, no prompt will 
be displayed.

A cable with one-to-one connections will work with a PC or an HP 9000 
Series 700 workstation.

If you have RS-232 connection problems with 
the MS Windows Terminal program

❏ Remember that Windows 3.1 only allows two active RS-232 
connections at a time. To be warned when you violate this 
restriction, choose Always Warn in the Device Contention group 
box under 386 Enhanced in the Control Panel.

❏ Use the “Terminal” program (usually found in the Accessories 
windows program group) and set up the “Communications...” 
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settings as follows:

When you are connected, hit the Enter key. You should get a prompt 
back. If nothing echos back, check the switch settings on the emulation 
probe.

❏ If the switches are in the correct position and you still do not get 
a prompt when you hit return, try turning OFF the power to the 
emulation probe and turning it ON again.

❏ If you still don’t get a prompt, make sure the RS-232 cable is 
connected to the correct port on your PC, and that the cable is 
appropriate for connecting the PC to a DCE device.

With certain RS-232 cards, connecting to an RS-232 port where the 
emulation probe is turned OFF (or is not connected) will hang the PC. 
The only way to get control back is to reboot the PC. Therefore, we 
recommend that you always turn ON the emulation probe before 
attempting to connect via RS-232.

%DXG�5DWH� ������RU�ZKDWHYHU�\RX�KDYH�FKRVHQ�IRU�WKH�HPXODWLRQ�SUREH�

'DWD�%LWV� �

3DULW\� 1RQH

)ORZ�&RQWURO� KDUGZDUH

6WRS�%LWV� �
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Updating Emulation Probe Firmware

Firmware gives your emulator a “personality” for a particular 
microprocessor or microprocessor family.

After you have connected the emulation probe to a LAN, you may need 
to update the firmware to give it the right personality for your 
microprocessor.

You must update the firmware if:

• You need to change the personality of the emulation probe for a new 
processor.

• You have an updated version of the firmware from HP.

To display current firmware version 
information

• Use telnet or a terminal emulator to access the built-in “terminal 
interface” and use the ver command to view the version 
information for firmware currently in the emulation probe.

To update firmware for an emulation probe

To update the firmware, you must have access to the World Wide Web 
and a PC or a workstation connected to your emulation probe.

1 Download the new firmware from the following World Wide Web 
site:

http://www.hp.com/go/emulator

The firmware will be in the “Technical Support Information” section of 
this web site.

2 Follow the instructions on the web site for installing the 
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firmware.

If HP sends you firmware on a floppy disk, install the firmware from the 
floppy disk. The README file on the floppy disk contains instructions 
for installing the firmware using a PC or workstation.
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Overview of Installation and Setup

Follow these steps to connect your equipment.

1 Check that you received all of the necessary equipment. See 
“Equipment and Requirements” on page 46.

2 Disconnect power from the target system and logic analyzer 
before you make or break connections.

3 Install the emulation module into the logic analysis system. See 
“Installing into a Logic Analysis System” on page 48.

4 Install software on the logic analysis system. See “Installing 
Software” on page 54.

5 Update the emulation module’s firmware to give it the proper 
“personality” for the microprocessor it will connect to. See 
“Updating Emulation Module Firmware” on page 56.

6 Connect the emulation module to your target system. See the 
“Connecting to a Target System” chapter on page 63.

7 Configure the emulation module. See the “Configuring the 
Emulation Probe/Module” chapter on page 75.
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Emulation module
HP E5901A

Install emulation module (if
necessary)

Install software on logic
analysis system

Update emulation module
firmware (if necessary)

Installation done. Begin
using emulation module.

Connect emulation module

Connect emulation
module  to target
interface module

Connect target interface
module to target
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Equipment and Requirements

Supplied Equipment and Software

The emulation module includes:

• An HP 16610A emulation module.

• Firmware for the emulation module and/or updated software for the 
Emulation Control Interface on a CD-ROM.

• A target interface module (TIM) circuit board.

The target interface module (TIM) is used to connect the emulation 
module to a debug port in the target system.

The target interface module (TIM) is not needed when using the 
HP E2490A analysis probe for MPC505/509 microprocessors because the 
target interface module’s functionality is already built into the analysis 
probe.

• A 50-pin ribbon cable for connecting the emulation module to the target 
interface module (TIM) (or to the HP E2490A analysis probe).

• A 10-pin ribbon cable for connecting the target interface module (TIM) to 
a debug port connector in the target system.

• One Torx T-10 and one Torx T-15 screwdriver.

• An emulation module loopback test board (HP part number E3496-66502)

• This User’s Guide.
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Additional Equipment and Software Required

The emulation module requires:

• An HP 16600A/16700A-series logic analysis system into which it can be 
installed.

• Interface software that gives you access to the emulation module’s 
functionality.

You can use the HP 16600A/16700A-series logic analysis system’ s 
Emulation Control Interface.

Or, you can use a third-party high-level source debugger to access and 
control the emulation module.
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Installing into a Logic Analysis System

Your emulation module may already be installed in your logic analysis 
system. However, if you need to install an emulation module, follow the 
instructions on the pages which follow.

CAUTION: These instructions are for trained service personnel. To avoid dangerous 
electric shock, do not perform any service unless qualified to do so. Do not 
attempt internal service or adjustment unless another person, capable of 
rendering first aid and resuscitation, is present.

Electrostatic discharge can damage electronic components. Use grounded 
wrist straps and mats when you handle modules.

To install in a HP 16700A-series logic analysis 
system

Or, to install in an HP 16701A expansion frame:

You will need a T-10 Torx screw driver.

1 Turn off the logic analysis system and REMOVE THE POWER 
CORD.

Remove any other cables (including mouse or video monitor cables).

2 Turn the logic analysis system frame upside-down.

3 Remove the bottom cover.
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4 Remove the slot cover.

You may use either slot.

5 Install the emulation module.
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6 Connect the cable and re-install the screws.

You may connect the cable to either of the two connectors. If you have 
two emulation modules, note that many debuggers will work only with 
the “first” module: the one toward the top of the frame (“Slot 1"), 
plugged into the connector nearest the back of the frame.
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7 Reinstall the bottom cover, then turn the frame right-side-up.

8 Plug in the power cord, reconnect the other cables, and turn on 
the logic analysis system.

The new emulation module will be shown in the system window.

See Also See “Updating Emulation Module Firmware” on page 56 for 
information on giving the emulation module a “personality” for your 
target processor.

To install in a HP 16600A-series logic analysis 
system

You will need a T-10 Torx screw driver.

1 Turn off the logic analysis system and REMOVE THE POWER 
CORD.

Remove any other cables (such as probes, mouse, or video monitor).

2 Slide the cover back.
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3 Remove the slot cover.

4 Install the emulation module.

5 Connect the cable and re-install the screws.
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6 Reinstall the cover.

Tighten the screws snugly (2 N-m or 18 inch-pounds).

7 Plug in the power cord, reconnect the other cables, and turn on 
the logic analysis system.

The new emulation module will be shown in the system window.

See Also See “Updating Emulation Module Firmware” on page 56 for 
information on giving the emulation module a “personality” for your 
target processor.

To test the emulation module

If this is the first time that you have used the emulation module, you 
should run the built-in performance verification test before you 
connect to a target system. Refer to “Solving Emulation Module 
Problems” on page 143 for information on performance verification.
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Installing Software

This chapter explains how to install the software you will need for your 
emulation module.

Installing and loading

Installing the software will copy the files to the hard disk of your logic 
analysis system. Later, you will need to load some of the files into the 
appropriate hardware module.

What needs to be installed

If you ordered an emulation module with your logic analysis system, 
the software was installed at the factory.

The following files are installed from the CD-ROM:

• Emulation module firmware.

• Emulation Control Interface.

To install software from CD-ROM

Installing a processor support package from a CD-ROM will take just a 
few minutes. If the processor support package requires an update to 
the HP 16600A/16700A-series logic analysis system’s operating system, 
installation may take approximately 45 minutes.

CD-ROM or
flexible disk

Install Load
Hard Disk

Logic analyzer
or emulation

module

Logic analysis system or logic analyzer frame
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NOTE: If the CD-ROM drive is not connected, see the instructions printed on the 
CD-ROM package.

1 Turn on the CD-ROM drive first; then, turn on the logic analysis 
system.

2 Insert the CD-ROM in the drive.

3 Click the System Admin icon.

4 Click Install... .

5 Select CD-ROM as the media, and click Apply.

6 From the list of types of packages, double-click “PROC-
SUPPORT.”

A list of the processor support packages on the CD-ROM will be 
displayed.

7 Click on the “MPC5XX” package.

If you are unsure if this is the correct package, click Details for 
information on what the package contains.

8 Click Install... .

The dialog box will display “Progress: completed successfully” when 
the installation is complete.

9 Click Close.

The firmware is stored in /hplogic/run_control/firmware.

See Also The on-line help for more information on installing, licensing, and 
removing software.
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Updating Emulation Module Firmware

Firmware gives your emulation module a “personality” for a particular 
microprocessor or microprocessor family.

After you have installed the emulation module into the logic analysis 
system, you may need to update the firmware to give it the right 
“personality” for your processor.

You must update the firmware if:

• You have an emulation module which was not shipped already installed in 
the logic analysis system.

• You need to change the personality of the emulation module for a new 
microprocessor.

• You have an updated version of the firmware from HP.

Always update firmware by installing a processor support package. 
This will ensure that the version of the Emulation Control Interface 
software is compatible the version of the emulator firmware.

To display current firmware version 
information 

• In the Update Firmware window, click Display Current Version.

There are usually two firmware version numbers: one for “Generics” 
and one for the personality of your processor.

To update firmware using the Emulation 
Control Interface

1 End any run control sessions which may be running.

2 In the Workspace window, remove any Emulator icons from the 
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workspace.

3 Install the processor support package from the CD-ROM, if 
necessary. 

4 In the system window, click the emulation module and select 
Update Firmware.

5 In the Update Firmware window, select the firmware to load into 
the emulation module.

6 Click Update Firmware.

In about 20 seconds, the firmware will be installed and the screen will 
update to show the current firmware version. 

See also “Installing Software” on page 54 for instructions on how to install the 
processor support package from the CD-ROM.

To update firmware using the Setup Assistant

The Setup Assistant is an on-line tool for connecting and configuring 
your logic analysis system for microprocessor and bus analysis. The 
Setup Assistant is available on the HP 16600A/16700A-series logic 
analysis systems.

This menu-driven tool will guide you through the connection 
procedures for connecting the logic analyzer to an analysis probe, an 
emulation module, or other supported equipment. It will also guide you 
through connecting an analysis probe to the target system.

1 Install the processor support package from the CD-ROM.
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2 Start the Setup Assistant by clicking its icon in the system 
window.

3 Follow the instructions displayed by the Setup Assistant.

See Also “Installing Software” on page 54 for instructions on how to install a the 
processor support package from the CD-ROM.
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Preparing for a Debugger

When using a debugger with an emulation module in the HP 16600A/
16700A-series logic analysis system, the logic analysis system must be 
set up on the local area network (LAN).

To connect the logic analysis system to the 
LAN

See the logic analysis system’s installation guide or on-line help for 
information on setting up a logic analysis system on the LAN.

Debuggers require information about a logic analysis system’s LAN 
connection so they can communicate with an emulation module. They 
need (write the information here for future reference):

• IP Address of Logic Analysis System __________________________

• Hostname of Logic Analysis System __________________________

• Gateway Address __________________________

• Port Number of Emulation Module __________________________
 59



Chapter 2: Installing the Emulation Module
Preparing for a Debugger
To change the port number of an emulation 
module

To view or change the port number of an emulation module:

1 Click on the emulation module icon in the system window of the 
logic analysis system; then, select Update Firmware.

2 Select Modify Lan Port....

3 If necessary, enter the new port number in the Lan Port Address 
field.

The new port number must not be 0-1000 and must not already be 
assigned to another emulation module.
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To verify LAN communication with the 
emulation module

1 Telnet to the IP address.

For example, on a UNIX system, enter “telnet <IP_address> 6472". 
This connection will give you access to the emulation module’s built-in 
terminal interface. You should see a prompt, such as “M>”.

2 At the prompt, type:

ver

You should then see information about the emulation module and 
firmware version.

3 To exit from this telnet session, type Ctrl-d at the prompt.

See Also For information on physically connecting the logic analysis system to 
the LAN and configuring its LAN parameters, see the installation guide 
or on-line help for your logic analysis system.
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Designing the Target System for an Emulation 
Probe/Module

When using the MPC5xx emulation probe/module, you need to be 
aware of the requirements it makes of target systems, and you need to 
consider how and when the emulation probe/module connects to the 
target system.

Target System Requirements

The DSDI and DSCK signals must not be actively driven by the target 
system when the debug port is being used.

The RESET and SRESET signals from the debug connector must be 
ORed with the respective RESET and SRESET signals that connect to 
the processor on the target system. They can be logically ORed or 
“wire-ORed” on the board. The emulation probe/module drives RESET 
and SRESET through 100 ohm resistors with an open-collector drivers. 
There is also 1.79 Kohm pullup to 3.3 volts on the RESET and SRESET 
lines.

The HP emulation probe/module adds about 40 pF to all target system 
signals routed to the debug connector. This added capacitance may 
reduce the rise time of the RESET and SRESET signals beyond the 
processor specifications. If so, the target may need to increase the pull-
up current on these signal lines.

Additional target requirements may be specified in the release notes in 
the “readme” file on the provided floppy disk.

Debug Port Connection

If you are using the HP E2490A analysis probe for MPC505/509 
microprocessors, your target system doesn’t need a debug port 
connector and you don’t have to use the supplied target interface 
module to connect to it because the analysis probe has a built-in 
connector for the emulation probe/module. Otherwise, the emulation 
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probe/module requires a debug port (BDM) connector in the target 
system.

The connector should be a dual row header strip (“Berg connector”), 
10 pins per inch, with 25 mil pins.

There are three possible pin outs of the BDM connector for the 
MPC555. While these can be picked based on the application, there are 
preferred pin outs for specific applications.

MPC505/509 Debug Port Connector

Pins 1 and 6 may be connected to VFLS0 and VFLS1 respectively, or, if 
a single freeze line is used, to the FRZ line.

MPC555 Debug Port Connector, Option 1

For maximum debug capability (access to BDM and program trace 
signals):

The E3497-66502 target interface module (TIM) requires 10k ohm 
pull-up resistors on pins 1 and 6.

The E3497-66503 target interface module (TIM) has 10k ohm pull-up 
resistors on pins 1 and 6.

9)/6��)5= � ■ ■ � 65(6(7
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Use the following commands to configure the emulation probe/module 
for this configuration:

cf proc=MPC555
cf dbgconfig=1
rst -m

NOTE: The MIOS1TPCR (0x0030 6800) register is modified to configure J18 and K18 
as VFLS0/1 pins. Software must not modify this register.

Option 1 is recommended because it leaves Program Trace pins for full 
analysis support. The other two options sacrifice watchpoint pins or 
program trace pins, thus forcing you to trade off analysis features.

MPC555 Debug Port Connector, Option 2

For maximum external bus capability:

The E3497-66502 (as well as the E3497-66503) target interface 
module (TIM) is compatible with the MPC555 processor debug port.

Use the following commands to configure the emulation probe/module 
for this configuration:

cf proc=MPC555
cf dbgconfig=2 (default probe setting)
rst -m

,:3��9)/6� � ■ ■ � 65(6(7

*1' � ■ ■ � 7&.B'6&.
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MPC555 Debug Port Connector, Option 3

For maximum I/O configuration:

The E3497-66502 target interface module (TIM) requires 10k ohm 
pull-up resistors on pins 1 and 6.

The E3497-66503 target interface module (TIM) has 10k ohm pull-up 
resistors on pins 1 and 6.

Bit 13 of the SIUMCR (0x002fc000) is set to enable FRZ. Software must 
not change this bit.

Use the following commands to configure the emulation probe/module 
for this configuration:

cf proc=MPC555
cf dbgconfig=3
rst -m

SYPCR Register

SYPCR register is a write once register containing software watchdog 
timers.

The cf_sypcr register default value of 0xffffff88 is loaded into SYPCR 
on the reset->break (or rst -m) sequence of commands.

This disables the watchdog timer. If another value of SYPCR needs to 
be loaded, change the cf_sypcr register before issuing the reset->break 
sequence of commands.

The reset->run sequence does not copy cf_sypcr into the real SYPCR 
on the processor which may cause debugging to be unstable.

6*3,2��)5=�375
 � ■ ■ � 65(6(7
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On-Chip Flash Support

The emulation probe/module will not directly support on-chip flash. 
Flash support should be provided by 3rd party debug vendors.

Fast Download

The HP probe will automatically use the chip’s internally supported 
fast download mode.
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Making the Target System Connection

Choose one of the following methods for connecting the emulation 
probe/module to a target system.

• Directly through a debug port connector on the target board.

• Through an HP E2490A analysis probe for MPC505/509 
microprocessors, which provides a direct connection to the debug 
port pins.

NOTE: The HP E2490A analysis probe for MPC505/509 microprocessors does not 
support the MPC555 microprocessor.

After you have connected the emulation probe/module to your target 
system, you may need to update the firmware in the emulation module.

See Also For information on designing a debug port on your target board, see 
“Designing the Target System for an Emulation Probe/Module” on 
page 64.

To connect to a target system debug port

The emulation probe/module can be connected to a target system 
through a 10-pin debug port (BDM connector). The emulation module 
should be connected to a 10-pin male 2x5 header connector on the 
target system using the 10-conductor cable assembly provided.

1 Turn off the target system and disconnect it from all power 
sources.

2 Plug one end of the 50-pin cable into the emulation probe/
module.
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3 Plug the other end of the 50-pin cable into the target interface 
module.

4 Plug one end of the 10-pin cable into the target interface module.

5 Plug the other end of the 10-pin cable into the debug port 
connector on the target system.
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6 Turn on the power to the logic analysis system and then the 
target system.

See Also For information on designing a target system for use with the 
emulation module, see “Designing the Target System for an Emulation 
Probe/Module” on page 64.

To connect to the analysis probe

1 Remove power from the target system.

2 Plug one end of the 50-pin cable into the emulation probe/
module.

3 Plug the other end of the 50-pin cable into the connector on the 
analysis probe.
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To verify communication with the target 
system

1 Turn on the target system.

2 Start the Emulation Control Interface.

If the electrical connections are correct, and if the emulator firmware 
and analysis probe or TIM match your target processor, the Run 
Control window should be displayed:
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The emulation probe/module has several user-configurable options. 
These options may be customized for specific target systems and saved 
in configuration files for future use.
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Entering Emulation Probe/Module Commands

Other ways to configure the emulation probe/module are by using:

• The emulation probe/module’s built-in terminal interface.

• Your debugger, if it provides an “emulator configuration” window that can 
be used with this HP emulation module.

To use the Emulation Control Interface

The easiest way to configure the emulation module is to use the 
Emulation Control Interface.

1 Start an Emulation Control Interface session.

In the system window, click the Emulation Control Interface icon, and 
then select “Start Session...”.

2 Open a Configuration window.

Select “Configuration...” from the Emulation Control Interface icon or 
from the Navigate menu in any Emulation Control Interface window.

7KH�HDVLHVW�ZD\�WR�FRQILJXUH�WKH�HPXODWLRQ�SUREH�PRGXOH�LV�WKURXJK�WKH�(PXODWLRQ�
&RQWURO�,QWHUIDFH�LQ�DQ�+3 �����$������$�VHULHV�ORJLF�DQDO\VLV�V\VWHP�

,I�\RX�XVH�WKH�(PXODWLRQ�&RQWURO�,QWHUIDFH��SOHDVH�UHIHU�WR�WKH�RQ�OLQH�KHOS�LQ�WKH�&RQILJXUDWLRQ�
ZLQGRZ�IRU�LQIRUPDWLRQ�RQ�HDFK�RI�WKH�FRQILJXUDWLRQ�RSWLRQV�
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3 Set the configuration options, as needed.

The configuration selections will take effect when you close the 
configuration window or when you move the mouse pointer outside the 
window.

4 Save the configuration settings.

To save the configuration settings, open the File Manager window and 
click Save....

See Also Help->Help on this window in the Configuration window for 
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information on each of the configuration options.

Help in the Emulation Control Interface menu for help on starting an 
Emulation Control session.

To use the built-in command interface

If you are unable to configure the emulation probe/module with the 
Emulation Control Interface or a debugger interface, you can configure 
the emulation probe/module using the built-in “terminal interface” 
commands.

1 Connect a telnet session to the emulation probe/module over the 
LAN.

For example, to connect to an emulation probe, enter:

telnet LAN_address

To connect to an emulation module in slot 1, enter:

telnet LAN_address 6472

2 Enter cf to see the current configuration settings.

3 Use the cf command to change the configuration settings.

See Also Enter help cf for help on the configuration commands.

For information on connecting using telnet, and for information on 
other built-in commands, see “Built-In Commands” on page 125.

([DPSOH To see a complete list of configuration items, type “help cf”. This 
command displays:

cf - display or set emulation configuration

cf - display current settings for all config items
cf <item> - display current setting for specified <item>
cf <item>=<value> - set new <value> for specified <item>
cf <item> <item>=<value> <item> - set and display can be combined

help cf <item> - display long help for specified <item>

--- VALID CONFIGURATION <item> NAMES ---
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proc - Set type of target processor
procck - Set clock speed of target processor
dprocck - Display default clock speed of target processor
dbgconfig - Define debug pin connection (MPC555 only)
rstword - Reset configuration word source (MPC505/509 only)
bnchardbrk - Set BNC break type
breakin - BNC break in control
rrt - Set restriction to real time runs
trigout - Trigger out control

M>

To use a debugger interface

Because the HP emulation probe/module can be used with several 
third-party debuggers, specific details for sending the configuration 
commands from the debugger to the emulation module cannot be given 
here. However, all debuggers should provide a way of directly entering 
terminal mode commands to the emulation module. Ideally, you would 
create a file that contains the modified configuration entries to be sent 
to the emulation module at the beginning of each debugger session.

See Also Information about specific debuggers in the “Using Debuggers” chapter 
on page 89.

Your debugger manual.
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Setting the MPC5xx Configuration Options

You must configure the processor probe to work with your target 
system.

The following options can be configured using the Emulation Control 
Interface or using built-in commands:

• Processor type.

• Processor clock speed.

• Debug port connection type (MPC555 only).

• Reset configuration word source (MPC505/509 only)

• “Break In” type.

The built-in “help cf” command also lists the following options, which 
are provided only for compatibility with stand-alone emulation probes:

• Trigger Out BNC.

• Trigger In BNC.

• BNC break type.

The following option can be configured using built-in commands:

• Restriction to real-time runs.

To configure the processor type

3URFHVVRU�W\SH�FRQILJXUDWLRQ

9DOXH 3URFHVVRU�SUREH�FRQILJXUHG�IRU %XLOW�LQ�FRPPDQG

03&��� 03&��� FI�SURF 03&���

03&��� 03&�����'HIDXOW� FI�SURF 03&���

03&��� 03&��� FI�SURF 03&���
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The cfsave -s command will store this configuration in the processor 
probe’s flash memory. The cfsave -r command will restore this 
configuration.

To configure the processor clock speed

The BDM communication speed will be 1/3 of the configured processor 
clock speed. You may set the processor clock speed to a speed lower 
than the actual clock speed of your target system.

You can also set the reset clock speed, which controls the BDM 
communication speed used after a reset, but before the Multiplication 
Factor in the SCCR is set up:

3URFHVVRU�FORFN�VSHHG�FRQILJXUDWLRQ

9DOXH 3URFHVVRU�FORFN�LV�DW�OHDVW %XLOW�LQ�FRPPDQG

�� ���0+] FI�SURFFN ��

�� ���0+] FI�SURFFN ��

�� ���0+] FI�SURFFN ��

� ��0+] FI�SURFFN �

� ��0+]��GHIDXOW� FI�SURFFN �

� ��0+] FI�SURFFN �

��� ����N+] FI�SURFFN ���

�� ���N+] FI�SURFFN ��

5HVHW�SURFHVVRU�FORFN�VSHHG�FRQILJXUDWLRQ

9DOXH 3URFHVVRU�FORFN�LV�DW�OHDVW %XLOW�LQ�FRPPDQG

�� ���0+] FI�GSURFFN ��

� ��0+] FI�GSURFFN �

�� ���N+] FI�GSURFFN ��
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To configure the debug port connection type

This configuration option is valid when the processor type has been 
configured for MPC555.

'HEXJ�SRUW�FRQQHFWLRQ�W\SH�FRQILJXUDWLRQ

9DOXH 3URFHVVRU�SUREH�FRQILJXUHG�IRU %XLOW�LQ�FRPPDQG

� 0D[LPXP�GHEXJ�FDSDELOLW\�
'HEXJ�SRUW�SLQ��� �03,2��9)/6�
'HEXJ�SRUW�SLQ��� �03,2��9)/6�
7KH�HPXODWLRQ�SUREH�VHWV�0,26�73&5 �[�����WR�
HQDEOH�9)/6>���@�SLQV�DIWHU�D�UHVHW�!EUHDN��1RWH��
UHVHW�!UXQ�ZLOO�QRW�ZRUN�
6HH�DOVR�´03&����'HEXJ�3RUW�&RQQHFWRU��2SWLRQ��µ�RQ�
SDJH ���

FI�GEJFRQILJ �

� 0D[LPXP�H[WHUQDO�EXV�FDSDELOLW\��'HIDXOW��
'HEXJ�SRUW�SLQ��� �9)/6��,:3�
'HEXJ�SRUW�SLQ��� �9)/6��,:3�
%\�GHIDXOW��WKH�SURFHVVRU�SRZHUV�XS�ZLWK�9)/6>���@�SLQ�
IXQFWLRQ�
6HH�DOVR�´03&����'HEXJ�3RUW�&RQQHFWRU��2SWLRQ��µ�RQ�
SDJH ���

FI�GEJFRQILJ �

� 0D[LPXP�,�2�FRQILJXUDWLRQ�
'HEXJ�SRUW�SLQ��� �6*3,2��)5=�375
'HEXJ�SRUW�SLQ��� �6*3,2��)5=�375
7KH�HPXODWLRQ�SUREH�VHWV�ELW����RI�6,80&5�WR�HQDEOH�
WKH�)5=�SLQ�DIWHU�D�UHVHW�!EUHDN��1RWH��UHVHW�!UXQ�
ZLOO�QRW�ZRUN�
6HH�DOVR�´03&����'HEXJ�3RUW�&RQQHFWRU��2SWLRQ��µ�RQ�
SDJH ���

FI�GEJFRQILJ �
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To configure the reset configuration word 
source

This configuration option is valid when the processor type has been 
configured for MPC505 or MPC509.

To configure the “Break In” type

This option affects how the emulation module will react to a trigger in 
an intermodule measurement.

5HVHW�FRQILJXUDWLRQ�ZRUG�VRXUFH

9DOXH :KLFK�UHVHW�FRQILJXUDWLRQ�ZRUG�ZLOO�EH�XVHG" %XLOW�LQ�FRPPDQG

LQW ,QWHUQDO� FI�UVWZRUG LQW

H[W ([WHUQDO� FI�UVWZRUG H[W

´%UHDN�,Qµ�W\SH�FRQILJXUDWLRQ

9DOXH :KDW�KDSSHQV�ZKHQ�WKH�HPXODWLRQ�PRGXOH�LV�
WULJJHUHG

0DVNDEOH $�WULJJHU�ZLOO�LPPHGLDWHO\�FDXVH�D�PDVNDEOH�EUHDN��,I�
WKH�PDVNDEOH�EUHDN�IDLOV��D�QRQ�PDVNDEOH�EUHDN�ZLOO�EH�
DWWHPSWHG��7KH�GHOD\�EHWZHHQ�DQ�DWWHPSWHG�PDVNDEOH�
EUHDN�DQG�WKH�QRQ�PDVNDEOH�EUHDN�ZLOO�DOORZ�PDQ\�
LQVWUXFWLRQV�WR�EH�H[HFXWHG���'HIDXOW�

1RQ0DVNDEOH $�WULJJHU�ZLOO�LPPHGLDWHO\�FDXVH�D�QRQ�PDVNDEOH�EUHDN��
8VH�WKLV�YDOXH�LI�\RX�DUH�WU\LQJ�WR�KDOW�WKH�SURFHVVRU�LQ�
DQ�LQWHUUXSW�VHUYLFH�URXWLQH��7KH�SURFHVVRU�PD\�QRW�EH�
DEOH�WR�FRQWLQXH�UXQQLQJ�DIWHU�WKH�EUHDN�
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To configure the Trigger Out BNC

To configure the Trigger In BNC

7ULJJHU�RXW�FRQILJXUDWLRQ

9DOXH 7KH�7ULJJHU�2XW�%1&�ZLOO %XLOW�LQ�FRPPDQG

IL[KLJK $OZD\V�EH�KLJK FI�WULJRXW IL[KLJK

IL[ORZ $OZD\V�EH�ORZ FI�WULJRXW IL[ORZ

PRQKLJK *R�KLJK�ZKHQ�WKH�SURFHVVRU�LV�UXQQLQJ�LQ�EDFNJURXQG�
�'HIDXOW�

FI�WULJRXW PRQKLJK

PRQORZ *R�ORZ�ZKHQ�WKH�SURFHVVRU�LV�UXQQLQJ�LQ�EDFNJURXQG FI�WULJRXW PRQORZ

7ULJJHU�LQ�FRQILJXUDWLRQ

9DOXH 0HDQLQJ %XLOW�LQ�FRPPDQG

RII ,QSXWV�WR�WKH�%UHDN�,Q�%1&�ZLOO�EH�LJQRUHG� FI�EUHDNLQ RII

ULVLQJ 7KH�SURFHVVRU�SUREH�ZLOO�FDXVH�D�EUHDN�RQ�D�ULVLQJ�
HGJH���'HIDXOW�

FI�EUHDNLQ ULVLQJ

IDOOLQJ 7KH�SURFHVVRU�SUREH�ZLOO�FDXVH�D�EUHDN�RQ�D�IDOOLQJ�
HGJH�

FI�EUHDNLQ IDOOLQJ
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To configure the BNC break type

To configure restriction to real-time runs

%1&�EUHDN�W\SH�FRQILJXUDWLRQ

9DOXH ([FHSWLRQV�ZKLFK�KDOW�RSHUDWLRQ�DQG�EUHDN�WR�
EDFNJURXQG

%XLOW�LQ�FRPPDQG

QR 7KH�DSSURSULDWH�LQSXW�WR�WKH�%UHDN�,Q�%1&�ZLOO�
LPPHGLDWHO\�FDXVH�D�PDVNDEOH�EUHDN��,I�WKH�PDVNDEOH�
EUHDN�IDLOV��D�QRQ�PDVNDEOH�EUHDN�ZLOO�EH�DWWHPSWHG��
7KH�GHOD\�EHWZHHQ�DQ�DWWHPSWHG�PDVNDEOH�EUHDN�DQG�
WKH�QRQ�PDVNDEOH�EUHDN�ZLOO�DOORZ�PDQ\�LQVWUXFWLRQV�WR�
EH�H[HFXWHG���'HIDXOW�

FI�EQFKDUGEUN QR

\HV 7KH�DSSURSULDWH�LQSXW�WR�WKH�%UHDN�,Q�%1&�ZLOO�
LPPHGLDWHO\�FDXVH�D�QRQ�PDVNDEOH�EUHDN��8VH�WKLV�
YDOXH�LI�\RX�DUH�WU\LQJ�WR�KDOW�WKH�SURFHVVRU�LQ�DQ�
LQWHUUXSW�VHUYLFH�URXWLQH�

FI�EQFKDUGEUN \HV

5HDO�WLPH�UXQV�FRQILJXUDWLRQ

9DOXH 3URFHVVRU�SUREH�FRQILJXUHG�IRU %XLOW�LQ�FRPPDQG

QR $OORZV�FRPPDQGV�ZKLFK�EUHDN�WR�WKH�PRQLWRU��
([DPSOHV�LQFOXGH�FRPPDQGV�ZKLFK�GLVSOD\�PHPRU\�RU�
UHJLVWHUV���'HIDXOW�

FI�UUW QR

\HV 1R�FRPPDQGV�DUH�DOORZHG�ZKLFK�EUHDN�WR�WKH�PRQLWRU��
H[FHSW�´EUHDN�µ�´UHVHW�µ�´UXQ�µ�RU�´VWHS�µ

FI�UUW \HV
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Testing the Emulation Probe/Module and the 
Target System

After you have connected and configured the emulation probe/module, 
you should perform some simple tests to verify that everything is 
working.

See Also See “Solving Emulation Probe Problems” on page 135 or “Solving 
Emulation Module Problems” on page 143 for information on testing 
the emulation probe/module hardware.

To test memory accesses

1 Start the Emulation Control Interface and configure the 
emulation probe/module, if necessary.

2 Open the Memory window.

3 Write individual locations or fill blocks of memory with patterns 
of your choosing.

The access size is the size of memory access that will be used to write 
or read the memory values.

4 Use the Memory I/O window to stimulate I/O locations by reading 
and writing individual memory locations.

To test by running a program

To more fully test your target, you can load simple programs and 
execute them.

1 Compile or assemble a small program and store it in a Motorola S-
Record or Intel Hex file.
 87



Chapter 4: Configuring the Emulation Probe/Module
Testing the Emulation Probe/Module and the Target System
2 Use the Load Executable window to download the program into 
RAM or flash memory.

3 Use the Breakpoints window to set breakpoints. Use the 
Registers window to initialize register values.

The new register or breakpoint values are sent to the processor when 
you press the Enter key or when you move the cursor out of the 
selected register field.

4 In the Run Control window, click Run.

5 Use the Memory Mnemonic window to view the program and use 
the Memory window to view any output which has been written 
to memory.
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Several companies sell source debuggers which work with the HP 
emulation probe/module.

Benefits of Using a Debugger

A debugger lets you:

• control (start and stop) the execution of your microprocessor

• step through your code at the source-code level

• set breakpoints

• single-step through source code

• examine variables

• modify source code variables

• download executable code to your target system

Compatibility with Other Logic Analysis System Tools

You can use your logic analysis system to trace and analyze target 
system execution while you use your debugger.

If the computer running the debugger is also running X Windows server 
software, you can display logic analyzer windows next to your 
debugger windows.

Minimum Requirements

To use a debugger with the emulation probe/module, you need:

• A debugger that is compatible with the emulation probe/module.

Ask your debugger vendor whether the debugger can be used with an HP 
emulation probe (which is also known as a “processor probe” or “software 
probe”) or an HP emulation module.

• A LAN connection between the PC or workstation that is running the 
debugger and the emulation probe or the HP 16600A/16700A-series logic 
analysis system (which contains the emulation module).

Emulation probes or emulation modules communicate with debuggers 
over the LAN.
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• To have the logic analysis system user interface displayed on your PC or 
workstation screen along with the debugger, your computer needs to be 
running X Windows server software.

Most UNIX workstations run X Windows server software, but on a PC you 
may need to install X Windows server software.
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Setting Up Debugger Software

The instructions in this section assume that your PC or workstation is 
already connected to the LAN and that you have already installed the 
debugger software according its documentation.

To use your debugger with the emulation probe/module:

1. Install the emulation probe/module (see the “Installing the Emulation 
Probe” chapter on page 13 or the “Installing the Emulation Module” 
chapter on page 43).

2. Connect the emulation probe/module to your target system (see the 
“Connecting to a Target System” chapter on page 63).

3. If you are using the debugger with an emulation module in a logic analysis 
system, you must connect the logic analysis system to the LAN (see “To 
connect the logic analysis system to the LAN” on page 59).

4. If you want to display logic analysis system windows next to your debugger 
windows, export the logic analysis system’s display to your PC or 
workstation (see “To view logic analysis system windows next to the 
debugger” on page 93).

5. Configure the emulation probe/module (see the “Configuring the 
Emulation Probe/Module” chapter on page 75).

If you use the logic analysis system’s Emulation Control Interface to 
configure the emulation probe/module, remember to end the Emulation 
Control Interface session before you start the debugger.

CAUTION: Do not use the Emulation Control Interface at the same time as a debugger.

The Emulation Control Interface and debuggers do not keep track of 
commands issued by other tools. If you use both at the same time, the tools 
may display incorrect information about the state of the processor, possibly 
resulting in lost data.

6. Begin using your debugger.

See Also Refer to the documentation for your debugger for more information on 
connecting the debugger to the emulation probe/module.
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To change the port number of an emulation 
probe/module

Some debuggers do not provide a way to specify an emulation probe/
module port number. In this case:

• The debugger will always connect to port 6470 (the default port number of 
an emulation probe, or the port number of the emulation module in slot 1 
of an HP 16600A/16700A-series logic analysis system).

• If the port number of the emulation probe/module is not 6470, you must 
change it.

To change the port number of an emulation probe, see “To configure 
LAN parameters using the built-in terminal interface” on page 23.

To change the port number of an emulation module, see “To change the 
port number of an emulation module” on page 60.

To view logic analysis system windows next to 
the debugger

1 Make sure the computer running the debugger is also running 
X Windows server software and has telnet software.

2 Give the logic analysis system permission to display on the 
X Windows server.

3 Connect to the logic analysis system, log in, and start a session, 
displaying on the X Windows server.
 93



Chapter 5: Using Debuggers
Setting Up Debugger Software
([DPSOH��81,; On a UNIX workstation:

1. Add the host name of the logic analysis system to the list of systems 
allowed to make connections:

xhost +<IP_address>

2. Use telnet to connect to the logic analysis system.

telnet <IP_address

3. Log in as “hplogic”.

The logic analysis system will open a Session Manager window on your 
display.

4. In the Session Manager window, click Start Session on This Display.

([DPSOH��3& On a Windows 95 PC with Reflection X server software from Walker 
Richer & Quinn, Inc.:

1. On the PC, start the X Windows server software and connect to the logic 
analysis system.

To start Reflection X, click the Reflection X Client Startup icon. Enter the 
following values in the Reflection X Client Startup dialog:

a. In the Host field, enter the hostname or IP address of the logic analysis 
system.

b. In the User Name field, enter “hplogic”.

c. Leave the Password field blank.

d. Leave the Command field blank.

e. Click Run to start the connection.

The logic analysis system will open a Session Manager window on your 
display.

2. In the Session Manager window, click Start Session on This Display.
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Using the Green Hills Debugger

Compatibility

Version 1.8.8.A of the MULTI Development Environment from Green 
Hills Software, Inc. is one debugger that connects to the HP emulation 
probe/module.

This information in this section is intended to be used along with the 
MULTI documentation provided by Green Hills Software.

Overview

MULTI connects to an emulation probe/module through the Green Hills 
host-resident program (hpserv).

To get started

1 Build the executable.

If you have the demo software shipped with the Green Hills debugger, 
follow these steps:

a Prepare the executable.
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Go to the hpdemo subdirectory where you installed MULTI. Copy the 
mbx800.lnk file to user.lnk.

You may need to edit the user.lnk file to place the program at a location 
where target system memory is available.

b Start MULTI.

On Unix, enter “multi”.

On Windows, double-click the Green Hills icon.

c Set up the MULTI software environment:

• Replace the project default.bld (in the Builder dialog box next to the 
project button) with hpdemo/default.bld and press ENTER.

• Make sure the target button on the MULTI window says “PPC”.

• In the Builder window, double-click ecs.bld.

The box next to the Debug button should display “ecs”. The window 
should list the names of the source code files.

d In the Builder menu bar, select Options->CPU, then set the 
processor type.

e In the Builder menu bar, select Options->Advanced, and make 
sure that “Output DWARF on ELF targets” option is enabled.

f Build the demo program:

• In the Builder window, click the Build icon. (Or, in the menu bar, select 
Build->Build All.)

• Close the Progress window when the “Build completed” message is 
displayed.

2 Connect MULTI to the emulation probe/module.

There are two ways to connect to the emulation probe/module:

• In the Remote box in the MULTI Builder window, enter:

hpserv IP_address

OR
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• In the Builder window, click Debug to open the Debugger window; then, in 
the Debugger window’s command pane, enter:

remote hpserv IP_address

Starting hpserv opens two windows: the Target window and the I/O 
window. Commands entered in the Target window are sent directly to 
the emulation probe/module.

The I/O window sends input (stdin) to and receives output (stdout) 
from the target program while it is running.

Note that hpserv connects to the first emulation probe/module (port 
6470) in a logic analysis system frame. You may specify another port by 
using the -p option with hpserv. See “To connect the logic analysis 
system to the LAN” on page 59 for more information on port numbers.

3 Start the debugger.

If you have not opened the Debugger window yet, click Debug in the 
Builder window.

4 Configure the emulation probe/module and target system.

Before running the target processor, you must configure the HP 
emulation probe/module for your target system. For example, you may 
have to set the BDM clock speed, the reset operation, cache disabling, 
or other configuration parameters.

If you are unsure of the configuration needed for your emulation probe/
module, you can use one of the following methods to explore the 
configuration options and configure the emulation probe/module and 
target system:

• Enter “cf” commands in the Target window.

• Use the Configuration window in the logic analysis system’s Emulation 
Control Interface.

• Use an initialization script.

See “To configure using an initialization script” on page 98 for 
information on saving the configuration commands in a script.
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5 Specify an initialization address for the stack pointer.

This is required if the stack pointer is neither initialized when the 
processor is reset nor set in the start-up code generated by the 
compiler. If the stack pointer address needs to be initialized:

• In the debugger’s command pane, enter:

_INIT_SP = <address>

OR

• In the Target window, enter:

reg r1=<address>

OR

• Include the following line in an initialization script:

target reg r1= <address>

6 Download the code:

In the Debugger window, select Remote->LoadProgram.

The Debugger command pane indicates that the code has been 
downloaded to the target.

To configure using an initialization script

You can use an initialization script to configure the emulation probe/
module and set up your target system. If you will always be using the 
same configuration, this way will save time and reduce errors.

1 Save the configuration commands in a text file, one command 
per line.

Green Hills also provides an example initialization sequence in the file 
MBX800.rc in the “hpdemo” directory.

2 To run the script, enter the following command in the Debugger 
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command pane:

< filename

([DPSOH Create a file with the following lines:

remote hpserv hplogic1
target cf proc=MPC505
_INIT_SP=0x10000

Save the file in the MULTI startup directory and name it hpserv.rc. To 
run the script, enter the following command in the Debugger command 
pane:

<hpserv.rc

When run, this script will:

• Connect to the target through the emulation probe/module in a logic 
analysis system frame called “hplogic1”.

• Set the processor type to MPC505.

• Initialize the stack pointer.

To perform common debugger tasks

• To display registers, click the regs button in the Display window.

• To set a breakpoint, right-click on the source code line where the 
breakpoint is to be located.

• To clear a breakpoint, right-click again on the source line.

• To step through code, click next.

• To run from the current PC, click go.

• To toggle the display between source code and source code 
interlaced with assembly code, click assem.

• To load program symbols, reset the PC, reset the stack pointer, 
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and run from the start, click restart.

To send commands to the emulation probe/
module

MULTI communicates with the emulation probe/module using the 
emulation probe/module’s “terminal interface” commands. MULTI 
automatically generates and sends the commands required for normal 
operation.

If you want to communicate directly with the emulation probe/module 
during a debug session, you may do so using “terminal interface” 
commands through the Target window (which comes up when hpserv 
is brought up).

You can also enter terminal interface commands from the Debugger 
window’s command pane by preceding the command with the “target” 
command.

To view commands sent by MULTI to the 
emulation probe/module

The communication between MULTI and the emulation probe/module 
can be viewed by running hpserv in a logging mode:

remote hpserv -dc -a -o <filename> <emulation probe/
module name>

The options -dc and -da log both asynchronous and console messages 
and the -o <filename> directs these messages to a log file called 
<filename>. When using this option, disconnect from hpserv (to flush 
out the file) and then you may view <filename> to see what commands 
MULTI sent to the emulation probe/module.

NOTE: Logging commands in this way may result in a VERY large file. Beware of the 
disk space it may require.
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To reinitialize the system

If you suspect that the emulation probe/module is out of sync with the 
MULTI debugger, you may want to reinitialize it. Perform the steps 
below to accomplish reinitialization:

1 In the Target window, type:

init -c

2 Repeat steps 4 through 7 in “To get started” on page 95 to 
configure the emulation probe/module.

To disconnect from the emulation probe/
module

• In the Debugger window, select Remote->Disconnect.

The Debugger command pane indicates that the debugger has 
disconnected from the emulation probe/module.

Error conditions

“!ERROR 800! Invalid command: bcast”

This message usually means that there is no target interface module 
(TIM) connected to the emulation probe/module or that the emulation 
probe/module does not have firmware for the MPC500 family.

1. Verify that the emulation probe/module is connected to the target.

2. Next, check that your emulation probe/module is programmed with 
firmware for the Motorola MPC500:

For an emulation probe, see “To display current firmware version 
information” on page 40. If the emulation probe is not programmed with 
the proper firmware, see “To update firmware for an emulation probe” on 
page 40.
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For an emulation module, see “To display current firmware version 
information” on page 56. If the emulation module is not programmed with 
the proper firmware, see “To update firmware using the Emulation Control 
Interface” on page 56.

“command socket connection failed: WSAECONNREFUSED: connection refused”

This message usually means the emulation probe/module is not at port 
#6470 on the logic analysis system.

See Also Green Hills MULTI Software Development Environment User’s 

Guide.

Using MULTI with the Hewlett-Packard Processor Probe from Green 
Hills Software, Inc.

The Green Hills web site: http://www.ghs.com

See the “Configuring the Emulation Probe/Module” chapter on page 75 
for more information on configuration options and the “cf” command.
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Using the Microtec Research Debugger

Compatibility

Version 4.1 of the XRAY HP Probe debugger from Microtec Research, a 
Mentor Graphics Company, is another debugger that connects to the 
HP emulation probe/module.

This information in this section is intended to be used along with the 
XRAY documentation provided by Microtec Research.

Overview

To get started

1 Edit the gtw.brd file.

The file gtw.brd includes example hostnames, port numbers and 
initialization information for HP emulation probes/modules that might 
be on the network for XRAY to connect to. The gtw.brd file is in the 
“etc” directory under the Microtec tools directory.
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a Modify gtw.brd to identify the emulation probe/module.

Modify the file to include the emulation probe/module that you want XRAY 
to communicate with.

See “To connect the logic analysis system to the LAN” on page 59 for 
information on which port number to use for your emulation module.

b Add commands to initialize the target system.

The target system must have various memory locations initialized before it 
can access RAM and before XRAY can download an application. Normally, 
code in the target’s boot ROM performs this initialization. However, when 
XRAY resets the target, it immediately places the processor in debug 
mode. Therefore, any initialization code which may exist on the target 
board will not have been executed.

XRAY provides a way for target initialization to occur through the gtw.brd 
file. The initialization sequences (contained in “{}” pairs) included in the 
gtw.brd commands specify the commands that will be sent to the HP 
emulation probe/module to initialize it and prepare it for code download.

• The gtwinit command sequence defined in the gtw.brd file is sent to the 
HP emulation probe/module when XRAY is establishing connection 
with the probe/module.

• The gtwreset command sequence is sent to the emulation probe/
module when the XRAY “Reset” command is invoked.

The example gtw.brd file provided by Microtec Research contains 
initialization sequences which can be referenced. If the configuration for 
your target board is very involved, you can use the “gtwinit” definition in 
gtw.brd to merely reset the processor and break and use an include file to 
do the many configuration steps. Please refer to “To configure the 
emulation probe/module using an INCLUDE file” on page 106 for more 
information on using an include file.

If you are unsure of the configuration needed for your emulation probe/
module, you can telnet to the emulation module or use the Configuraton 
window in the logic analysis system’s Emulation Control Interface to 
explore the configuration options. If you use this interface to actually 
configure your emulation probe/module while connected to XRAY, 
configuration will be complete and you can proceed to the next step.
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NOTE: You must start up XRAY from scratch after gtw.brd is modified for the changes 
you have made in gtw.brd to be recognized by XRAY.

2 Start XRAY.

After modifying gtw.brd, bring up the XRAY debugger. When XRAY 
comes up, the Managers dialog will be highlighted. (If the dialog is not 
present, the Managers dialog can be brought up from the Output 
Logging Window by selecting Managers->Connection Manager).

Using the Managers dialog, set up the connection to your HP emulation 
probe/module by selecting the Connect tab, clicking on your emulation 
probe/module name in the lower Available Connections table and click 
on the connect button. You should see your emulation probe/module 
name appear in the Active Connections table in the top half of the 
dialog. At this point, you are connected to the emulation probe/module 
and the initialization commands specified in the gtw.brd file have been 
sent to your emulation probe/module. If you look in the Output Logging 
Window, you can verify that the connection and initialization did in fact 
take place.

3 Download the application code.

In the Managers dialog, select the Debug tab, then select Execution-
>Load File to Target or Control->Load File to Target. This will open the 
“Load File To Target” dialog. (Alternatively, you may select the Files 
tab and select Load->Load File to Target.)

Use the Load File To Target dialog to choose the file you would like to 
download. When the file you want is listed in the center window, you 
may double click on it to start the load.

When the load is complete, you will see the file you loaded appear in 
the Active Files window of the File tab and in the Active Processes 
window of the Debug tab. You are now ready to debug your application 
code.
 105



Chapter 5: Using Debuggers
Using the Microtec Research Debugger
To configure the emulation probe/module 
using an INCLUDE file

You can use an include file to configure the emulation probe/module 
and set up your target system after bringing up the XRAY debugger. If a 
complex configuration is needed for your emulation probe/module and 
target (such as multi-commands sent to the emulation probe/module) 
this will save time and reduce errors.

1 Save the configuration commands in a text file, one command 
per line. Microtec Research provides an example include file in 
its tools directory under the xhippchp directory in the file 
“mo8xxads.inc”.

2 To run the include file, select “Include Commands from File” 
under the Debug menu in the Code window and double click on 
the include filename you want to execute.

To perform common debugger tasks

• To display registers, select Register under the Windows menu in 
the Code window.

• To set a breakpoint, double-click on the source code line where 
the breakpoint is to be located.

• To clear a breakpoint, double-click on the line where the 
breakpoint is set.

• To step through code, select one of the step icons at the top of 
the Code window.

• To run from current PC, click on the first icon in the Code 
window.

• To toggle the display between source code and source code 
interlaced with assembly code, click on the Dsm button at the 
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bottom of the code display window.

• To load program symbols, reset the PC, reset the stack pointer, 
and run from start, click restart.

To send commands to the emulation probe/
module

“Terminal interface” commands may be sent directly to the emulation 
probe/module from XRAY. There are two ways to do this:

• Using an include file (as explained in the “Using an INCLUDE file 
to configure the emulation probe/module and target” section)

OR

• Using the XRAY “cf” command.

This command takes a string as a parameter and sends it to the 
emulation probe/module. For example, if you want to send the 
emulation probe/module command cf proc=MPC505, you can type

cf "proc=MPC505"

in the XRAY Debugger command line.

Note that the command must be surrounded by double quotes.

To view commands sent by XRAY

XRAY communicates with the emulation probe/module using the 
emulation probe/module’s “terminal interface” commands. XRAY 
automatically generates and sends the commands required for normal 
operation. The communication between XRAY and the emulation 
probe/module can be logged to a file after a connection has been 
established between XRAY and the emulation probe/module and 
viewed later. To enable logging, enter the command:

PROBEMESSAGE ON,msgfile
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This will create the “msgfile” and log a summary of the messages that 
occur between XRAY and the emulation probe/module to it. The 
logging can be turned off with the following command:

PROBEMESSAGE OFF

To disconnect from the emulation probe/
module and target

In the Managers window, select the Connect tab. Click on the 
emulation probe/module name that you want to disconnect. Under the 
Control menu, select “Disconnect from Board” (or you can “Reconnect 
to Board” if you have lost connection to the emulation probe/module).

Error conditions

“!ERROR 800! Invalid command: bcast”

This message usually means that there is no target interface probe/
module (TIM) connected to the emulation probe/module or the 
emulation probe/module does not have firmware for the MPC500 
family.

1. Verify that the emulation probe/module is connected to the target.

2. Next, check that your emulation probe/module is programmed with 
firmware for the Motorola MPC500:

For an emulation probe, see “To display current firmware version 
information” on page 40. If the emulation probe is not programmed with 
the proper firmware, see “To update firmware for an emulation probe” on 
page 40.

For an emulation module, see “To display current firmware version 
information” on page 56. If the emulation module is not programmed with 
the proper firmware, see “To update firmware using the Emulation Control 
Interface” on page 56.
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“command socket connection failed: WSAECONNREFUSED: connection refused”

This message usually means the emulation probe/module is not at port 
#6470 on the logic analysis system.

See Also The Microtec Research web site: http://www.mentorg.com/microtec

The XRAY Debugger Reference Manual by Microtec Research.

See the “Configuring the Emulation Probe/Module” chapter on page 75 
for more information on configuration options and the “cf” command.
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Using the Software Development Systems 
Debugger

Compatibility

Version 7.3 of the SingleStep debugger from Software Development 
Systems, Inc. is another debugger that connects to the HP emulation 
probe/module.

The information in this section is intended to be used along with the 
SingleStep documentation provided by SDS.

Overview

Startup Behavior

The following actions are performed at the start of a session and when 
you select File->Debug:

• If the reset target option is selected, the target is reset.

• Hardware breakpoints are disabled.

• Software breakpoints are enabled.

• All breakpoints are cleared.
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• main() _exit breakpoints are set, if that option is selected.

To get started

1 Connect to the emulation probe/module:

a Start SingleStep running on your PC or workstation.

b When the small Debug dialog box appears in the middle of the 
screen, click the Connection tab and then enter the IP address 
of the HP logic analysis system which contains the emulation 
probe/module.

If the Debug dialog box is not visible, select File->Debug.

NOTE: SingleStep is hard-coded to connect to the emulation probe/module at port 
6470. See “To change the port number of an emulation probe/module” on 
page 93 for more information on port numbers.

2 Configure the emulation probe/module with the processor clock 
speed.

In the Debug dialog box, click the Connection tab and then enter a 
Processor Clock speed which is less than or equal to the speed at which 
the processor will run out of reset.

The emulation probe/module must know the target clock speed before 
it can communicate with the target. This value depends on the 
oscillator or crystal used on your target system and the multipliers 
applicable at reset. The communications speed can be changed (see 
“Download performance” on page 114) but will be reset to this value 
each time SingleStep resets the processor.

3 Initialize the target system.

The target system must have various registers and memory locations 
initialized before it can access RAM and before SingleStep can 
download an application. Normally, code in the target’s boot ROM 
performs this initialization. However, when SingleStep resets the 
target, it immediately places the processor in debug mode. Any 
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initialization code which may exist on the target board has not been 
run.

SingleStep provides a way for target initialization to occur without 
running application code through the use of the Target Configuration 
tab in the “Debug” dialog box.

An alternate way of performing target initialization is by using the 
_config alias. _config is used to define a list of commands that will be 
used to initialize the target after a reset. The _config alias should be 
defined in the sstep.ini file (in the “cmd” directory).

The “Debug” dialog method and the sstep.ini method are mutually 
exclusive. Use one or the other, but not both.

Initialization of the target will not actually occur until the “Debug” 
dialog is successfully exited.

4 Set up the Loading and Execution options in the Options tab of 
the Debug dialog.

5 Download the application and run:

Select the File tab and enter the application file name. Exit the 
“Debug” dialog box by clicking OK.

Emulation probe/module initialization and target initialization occur 
every time the “Debug” dialog is terminated via the OK button. A 
summary of the actions taken by SingleStep is given here:

• Initialize the emulation probe/module with the communication speed 
specified in the “Debug” dialog.

• If “load image” was selected, download the application and set the PC 
based on object module file contents.

• If “reset target” was selected, execute the commands specified by the 
_reset alias. The _reset alias should be used to specify commands that are 
specific to initializing the processor. It is executed each time the processor 
is reset. The value of the _reset alias can be viewed by issuing a “alias 
_reset” from the command window.

• Execute the commands specified by the _config alias. The _config alias 
should be used to specify commands that are specific to initializing 
(configuring) the target system. It is executed each time the processor is 
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reset and each time the debug dialog is exited. The value of the _config 
alias can be viewed by issuing an “alias _config” from the command 
window.

• If “execute until main” was selected, set a breakpoint at main() and run.

To send commands to the emulation probe/
module

To view commands sent by SingleStep

SingleStep communicates to the emulation probe/module using the 
emulation probe/module’s “terminal interface” commands. SingleStep 
automatically generates and sends the commands required for normal 
operation. This communication between SingleStep and the emulation 
probe/module can be observed by entering the following command in 
the SingleStep command window:

control -ms

To send commands

“Terminal interface” commands may be sent directly to the emulation probe/
module from the SingleStep command window or included in SingleStep’s .cfg 
or .dbg command files.
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Commands should be enclosed in double quotes and given the prefix: 
Ctrl-c.

([DPSOHV To see the speed that the emulation probe/module is using to 
communicate with the target system you would issue the following 
command in the SingleStep command window:

control -c "cf procck"

To change the speed to match a 25MHz processor clock you would 
issue the following command in the command window:

control -c "cf procck=25"

For more information about “terminal interface” commands see “Built-
In Commands” on page 125.

Download performance

Downloads are fastest when the emulation probe/module speed is set 
to match that of the target processor.

The initial speed that the emulation probe/module uses to 
communicate with the target processor is set by the Processor clock 
item in the Connection tab of the “Debug” dialog.

You are responsible for specifying this speed to be less than or equal to 
the initial, reset speed of the processor. Usually a setting in the Target 
Configuration tab of the Debug dialog or a command in the _config alias 
will raise the speed of the processor above its initial, reset value.

For maximum download performance, the command to increase the 
target processor speed should be followed by a command to increase 
the speed of the emulation probe/module communication.

([DPSOH The mpc505.cfg file contains the following command which writes to 
the SCCR register to set the processor speed to 28 MHz (assumes a 
4 MHz crystal).

write -l 0x8007fc50 = 0x041800000
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The following command, which increases the emulation probe/module 
communication speed, should be placed immediately after the write 
command shown above.

control -c "cf procck=25"

On-chip breakpoints and debugging ROM code

The MPC500 has a built-in hardware breakpoint capability. When 
SingleStep steps one source line or sets a user defined breakpoint, it 
will first try to use a software breakpoint. If the breakpoint does not 
work because the breakpoint address is located in ROM, SingleStep will 
automatically attempt to use one of the available hardware 
breakpoints. For more information, see the SingleStep release notes.

To debug ROM based code, unselect “Load Application Image” in the 
options tab of the “Debug” dialog.

Error conditions

“!ERROR 800! Invalid command: bcast”

This message usually means that there is not a target interface module 
(TIM) connected to the emulation probe/module or the emulation 
probe/module does not have firmware for the MPC500 family.

1. Verify that the emulation probe/module is connected to the target.

2. Next, check that your emulation probe/module is programmed with 
firmware for the Motorola MPC500:

For an emulation probe, see “To display current firmware version 
information” on page 40. If the emulation probe is not programmed with 
the proper firmware, see “To update firmware for an emulation probe” on 
page 40.

For an emulation module, see “To display current firmware version 
information” on page 56. If the emulation module is not programmed with 
the proper firmware, see “To update firmware using the Emulation Control 
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Interface” on page 56.

“command socket connection failed: WSAECONNREFUSED: connection refused”

This message usually means the emulation probe/module is not at port 
#6470. See “To change the port number of an emulation probe/module” 
on page 93.

“unrecognized hostname”

This message usually means that the debugger is unable to establish 
communication with the emulator.

• Verify communication to the emulation probe/module by doing a ping to 
the emulation probe or to the logic analysis system.

If you are unable to ping the emulator probe or logic analysis system, refer 
to “Solving LAN Communication Problems” on page 31 or the logic analysis 
system on-line help, respectively, for more information.

See Also The SDS web site: http://www.sdsi.com

The SDS SingleStep Users Guide.

See the “Configuring the Emulation Probe/Module” chapter on page 75 
for more information on configuration options and the “cf” command.
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If you have problems with the emulation probe/module, your first task 
is to determine the source of the problem. Problems may originate in 
any of the following places:

• The connection between the emulation probe/module and your debugger 
(PC or UNIX workstation) or the connection between the emulation probe 
and the logic analyzer.

• The emulation probe/module itself.

• The connection between the emulation probe/module and the target 
interface module.

• The connection between the target interface module and the target 
system.

• The target system.

You can use several means to determine the source of the problem:

• The troubleshooting guide on the next page.

• The status lights on the emulation probe/module.

• The emulation probe/module “performance verification” tests.

• The emulation probe/module’s built-in “terminal interface” commands.
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Troubleshooting Guide
 

&RPPRQ�HPXODWLRQ�SUREH�SUREOHPV�DQG�ZKDW�WR�GR�DERXW�WKHP

6\PSWRP :KDW�WR�GR 6HH�DOVR

+RVW�FRPSXWHU�UHSRUWV�
/$1�FRQQHFWLRQ�SUREOHPV

)ROORZ�WKH�FKHFNOLVW�LQ�WKH�´,I�\RX�KDYH�/$1�SUREOHPVµ�
VHFWLRQ�

SDJH ��

&RPPDQGV�IURP�WKH�
(PXODWLRQ�&RQWURO�
,QWHUIDFH�RU�GHEXJJHU�
KDYH�QR�HIIHFW

��9HULI\�/$1�FRPPXQLFDWLRQ� SDJH ��

��&KHFN�WKDW�\RX�DUH�XVLQJ�WKH�FRUUHFW�ILUPZDUH�IRU�\RXU�FKLS� SDJH ��

��8VH�D�WHOQHW�FRQQHFWLRQ��RU�VHULDO�FRQQHFWLRQ��WR�WU\�D�IHZ�
EXLOW�LQ�FRPPDQGV��,I�WKLV�ZRUNV��\RXU�GHEXJJHU�PD\�QRW�EH�
FRQILJXUHG�SURSHUO\��,I�WKLV�GRHV�QRW�ZRUN��FRQWLQXH�ZLWK�WKH�
QH[W�SURFHGXUH���

SDJH ���

(PXODWLRQ�SUREH�EXLOW�LQ�
FRPPDQGV�GR�QRW�ZRUN

��&KHFN�WKDW�WKH�HPXODWRU�KDV�EHHQ�SURSHUO\�FRQILJXUHG�IRU�
\RXU�WDUJHW�V\VWHP�

SDJH ��

��5XQ�WKH�HPXODWRU�SHUIRUPDQFH�YHULILFDWLRQ�WHVWV� SDJH ���

��,I�WKH�SHUIRUPDQFH�YHULILFDWLRQ�WHVWV�SDVV��WKHQ�WKHUH�LV�DQ�
HOHFWULFDO�SUREOHP�ZLWK�WKH�FRQQHFWLRQ�WR�WKH�WDUJHW�SURFHVVRU�
25�WKH�WDUJHW�V\VWHP�PD\�QRW�KDYH�EHHQ�GHVLJQHG�DFFRUGLQJ�
WR�´'HVLJQLQJ�D�7DUJHW�6\VWHP�µ

SDJH ��

´6ORZ�RU�PLVVLQJ�FORFNµ�
PHVVDJH�DIWHU�D�ORJLF�
DQDO\]HU�UXQ

&KHFN�WKDW�WKH�WDUJHW�V\VWHP�LV�UXQQLQJ�XVHU�FRGH�

6RPH�FRPPDQGV�IDLO &KHFN�WKH�´UHVWULFW�WR�UHDO�WLPH�UXQVµ�FRQILJXUDWLRQ SDJH ��
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&RPPRQ�HPXODWLRQ�PRGXOH�SUREOHPV�DQG�ZKDW�WR�GR�DERXW�WKHP

6\PSWRP :KDW�WR�GR 6HH�DOVR

&RPPDQGV�IURP�WKH�
(PXODWLRQ�&RQWURO�
,QWHUIDFH�KDYH�QR�HIIHFW

&KHFN�WKDW�\RX�DUH�XVLQJ�WKH�FRUUHFW�ILUPZDUH�

&RPPDQGV�IURP�
GHEXJJHU�KDYH�QR�HIIHFW

8VH�WKH�(PXODWLRQ�&RQWURO�,QWHUIDFH�WR�WU\�D�IHZ�EXLOW�LQ�
FRPPDQGV��,I�WKLV�ZRUNV��\RXU�GHEXJJHU�PD\�QRW�EH�
FRQILJXUHG�SURSHUO\��,I�WKLV�GRHV�QRW�ZRUN��FRQWLQXH�ZLWK�WKH�
VWHSV�IRU�WKH�QH[W�V\PSWRP����

SDJH ���

(PXODWLRQ�PRGXOH�EXLOW�LQ�
FRPPDQGV�GR�QRW�ZRUN

��&KHFN�WKDW�WKH�HPXODWLRQ�PRGXOH�KDV�EHHQ�SURSHUO\�
FRQILJXUHG�IRU�\RXU�WDUJHW�V\VWHP�

SDJH ��

��5XQ�WKH�HPXODWLRQ�PRGXOH�SHUIRUPDQFH�YHULILFDWLRQ�WHVWV� SDJH ���

��,I�WKH�SHUIRUPDQFH�YHULILFDWLRQ�WHVWV�SDVV��WKHQ�WKHUH�LV�DQ�
HOHFWULFDO�SUREOHP�ZLWK�WKH�FRQQHFWLRQ�WR�WKH�WDUJHW�SURFHVVRU�
25�WKH�WDUJHW�V\VWHP�PD\�QRW�KDYH�EHHQ�GHVLJQHG�DFFRUGLQJ�
WR�´'HVLJQLQJ�D�7DUJHW�6\VWHP�µ

SDJH ����
SDJH ���

´6ORZ�RU�PLVVLQJ�FORFNµ�
PHVVDJH�DIWHU�D�ORJLF�
DQDO\]HU�UXQ

&KHFN�WKDW�WKH�WDUJHW�V\VWHP�LV�UXQQLQJ�XVHU�FRGH�RU�LV�LQ�
UHVHW���7KLV�PHVVDJH�FDQ�DSSHDU�LI�WKH�SURFHVVRU�LV�LQ�
EDFNJURXQG�PRGH��

´6ORZ�FORFNµ�PHVVDJH�LQ�
WKH�(PXODWLRQ�&RQWURO�
,QWHUIDFH�RU�́ F!µ�SURPSW�
LQ�WKH�EXLOW�LQ�WHUPLQDO�
LQWHUIDFH

&KHFN�WKDW�WKH�FORFN�UDWH�LV�SURSHUO\�FRQILJXUHG� SDJH ��

6RPH�FRPPDQGV�IDLO &KHFN�WKH�´UHVWULFW�WR�UHDO�WLPH�UXQVµ�FRQILJXUDWLRQ� SDJH ��
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Status Lights

The emulation probe and the emulation module use status lights to 
communicate various modes and error conditions.

The following table gives more information about the meaning of the 
power and target status lights.

❍ = LED is off
● = LED is on
✳ = Not applicable (LED is off or on)

Emulation Probe Status Lights

3RZHU�7DUJHW�6WDWXV�/LJKWV

3ZU�7DUJHW�/('V 0HDQLQJ

❍❍

❍❍
(PXODWLRQ�SUREH�LV�QRW�FRQQHFWHG�WR�SRZHU�VXSSO\

❍●

❍❍
1R�WDUJHW�V\VWHP�SRZHU��RU�HPXODWRU�LV�QRW�FRQQHFWHG�WR�WKH�WDUJHW�V\VWHP

❍●

❍●
7DUJHW�V\VWHP�LV�LQ�D�UHVHW�VWDWH

●●

●❍
2QO\�ERRW�ILUPZDUH�LV�JRRG��RWKHU�ILUPZDUH�KDV�EHHQ�FRUUXSWHG�

●●

❍❍
7KH�WDUJHW�SURFHVVRU�LV�LQ�GHEXJ�PRGH

❍●

●❍
7KH�WDUJHW�SURFHVVRU�LV�H[HFXWLQJ�XVHU�FRGH

●●

●●

7KH�WDUJHW�SURFHVVRU�LV�LQ�DQ�XQNQRZQ�VWDWH
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Emulation Probe Target/Power LEDs

3RZHU�7DUJHW�/('�'HVFULSWLRQ

/(' 'HVFULSWLRQ

6723 /LW�ZKHQ�WKH�WDUJHW�SURFHVVRU�LV�UXQQLQJ�LQ�GHEXJ�PRGH

3:5 /LW�ZKHQ�WKH�SRZHU�VXSSO\�LV�SURSHUO\�FRQQHFWHG�WR�WKH�HPXODWLRQ�SUREH

581 /LW�ZKHQ�WKH�WDUJHW�SURFHVVRU�LV�UXQQLQJ�LQ�QRUPDO��XVHU�SURJUDP��PRGH

5(6(7 /LW�ZKHQ�WKH�WDUJHW�V\VWHP�LV�LQ�D�UHVHW�VWDWH
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Emulation Probe LAN LEDs

/$1�/('�'HVFULSWLRQ

/(' 'HVFULSWLRQ

/,1. /LW�ZKHQ���%$6(�7�FRQQHFWLRQ�KDV�D�JRRG�OLQN��QRW�XVHG�IRU���%$6(�

7; /LW�ZKHQ�/$1�GDWD�LV�EHLQJ�WUDQVPLWWHG

32/ /LW�ZKHQ�WKH�SRODULW\�RQ�WKH�UHFHLYH�WZLVWHG�SDLU�LV�UHYHUVHG�IRU�D���%$6(�7�FRQQHFWLRQ

5; /LW�ZKHQ�/$1�GDWD�LV�EHLQJ�UHFHLYHG
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Emulation Module Status Lights

3RZHU�7DUJHW�6WDWXV�/LJKWV

3ZU�7DUJHW�/('V 0HDQLQJ

❍�5HVHW
❍�%UHDN
❍�5XQ

1R�WDUJHW�V\VWHP�SRZHU��RU�HPXODWLRQ�PRGXOH�LV�QRW�FRQQHFWHG�WR�WKH�WDUJHW�
V\VWHP

●�5HVHW
❍�%UHDN
❍�5XQ

7DUJHW�V\VWHP�LV�LQ�D�UHVHW�VWDWH

❍�5HVHW
●�%UHDN
❍�5XQ

7KH�WDUJHW�SURFHVVRU�LV�H[HFXWLQJ�LQ�'HEXJ�0RGH

❍�5HVHW
❍�%UHDN
●�5XQ

7KH�WDUJHW�SURFHVVRU�LV�H[HFXWLQJ�XVHU�FRGH

❍�5HVHW
●�%UHDN
●�5XQ

2QO\�ERRW�ILUPZDUH�LV�JRRG��RWKHU�ILUPZDUH�KDV�EHHQ�FRUUXSWHG�
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Built-In Commands

The emulation probe/module has some built-in “terminal interface” 
commands which you can use for troubleshooting.

You can access the terminal interface using:

• A telnet (LAN) connection.

• The Command Line window in the Emulation Control Interface.

• A “debugger command” window in your debugger.

• A serial port connection (emulation probe only, see “Connecting a 
Terminal to the Emulation Probe’s Serial Port” on page 34.)

To telnet to the emulation probe/module

You can establish a telnet connection to the emulation probe/module if:

• A host computer and the emulation probe or the logic analysis system 
containing the emulation module are both connected to a local-area 
network (LAN), and

• The host computer has the telnet program (often part of the operating 
system or an internet software package).

To establish a telnet connection:

1 Find out the port number of the emulation probe/module.

The default port number of an emulation probe is 6470. Because there 
is only one port in an emulation probe, you don’t have to include the 
port number in the telnet command.

The default port number of the first emulation module in an 
HP 16600A/16700A-series logic analysis system is 6472. The default 
port of a second emulation module is 6476. The default port numbers 
of a third and fourth module in an expansion frame are 6480 and 6484. 
These port numbers can be changed, but that is rarely necessary.
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2 Find out the IP address or hostname of the emulation probe or 
the logic analysis system containing the emulation module.

3 Start the telnet program.

For example, if the hostname of the emulator probe is “emprobe”, the 
command might look like this:

telnet emprobe

Or, for example, if the hostname of the logic analysis system is “test2” 
and you have only one emulation module installed, the command might 
look like this:

telnet test2 6472

4 If you do not see a prompt, press the Return key a few times.

To exit from this telnet session, type Ctrl-d at the prompt.

To use the built-in commands

Here are a few commonly used built-in commands:

8VHIXO�EXLOW�LQ�FRPPDQGV

E %UHDN³JR�LQWR�WKH�EDFNJURXQG�PRQLWRU�VWDWH

FI &RQILJXUDWLRQ³UHDG�RU�ZULWH�FRQILJXUDWLRQ�RSWLRQV

KHOS +HOS³GLVSOD\�RQ�OLQH�KHOS�IRU�EXLOW�LQ�FRPPDQGV

LQLW ,QLWLDOL]H³LQLW��F�UH�LQLWLDOL]HV�HYHU\WKLQJ�LQ�WKH�HPXODWLRQ�SUREH�PRGXOH�H[FHSW�IRU�WKH�/$1�
VRIWZDUH��LQLW��S�LV�WKH�HTXLYDOHQW�RI�F\FOLQJ�SRZHU��LW�ZLOO�EUHDN�/$1�FRQQHFWLRQV�

ODQ FRQILJXUH�/$1�DGGUHVV��HPXODWLRQ�SUREHV�RQO\�

P 0HPRU\³UHDG�RU�ZULWH�PHPRU\

UHJ 5HJLVWHU³UHDG�RU�ZULWH�D�UHJLVWHU

U 5XQ³VWDUW�UXQQLQJ�XVHU�FRGH

UHS 5HSHDW³UHSHDW�D�FRPPDQG�RU�JURXS�RI�FRPPDQGV

UVW 5HVHW³UHVHW�WKH�WDUJHW�SURFHVVRU��WKH�HPXODWLRQ�SUREH�PRGXOH�ZLOO�ZDLW�IRU�\RX�WR�SUHVV�
WKH�WDUJHW·V�5(6(7�EXWWRQ�

V 6WHS³GR�D�ORZ�OHYHO�VLQJOH�VWHS

YHU 9HUVLRQ³GLVSOD\�WKH�SURGXFW�QXPEHU�DQG�ILUPZDUH�YHUVLRQ�RI�WKH�HPXODWLRQ�SUREH�PRGXOH
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The prompt indicates the status of the emulation probe/module:

([DPSOHV To set register R0, then view R0 to verify that it was set, enter:

R>rst -m
M>reg r0=ffff
M>reg r0

reg R0=0000ffff

To break execution then step a single instruction, enter:

M>b
M>s

PC= xxxxxxxx
M>

To determine what firmware version is installed in the emulation probe/
module, enter:

M>ver

See Also Use the help command for more information on these and other 
commands. Note that some of commands listed in the help screens are 
generic commands for HP emulators and may not be available for your 
product.

If you are writing your own debugger, contact HP for more information.

(PXODWLRQ�SUREH�PRGXOH�SURPSWV

8 5XQQLQJ�XVHU�SURJUDP

0 5XQQLQJ�LQ�EDFNJURXQG�PRQLWRU

S 1R�WDUJHW�SRZHU

5 (PXODWLRQ�UHVHW

U 7DUJHW�UHVHW

" 8QNQRZQ�VWDWH
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Solving Target System Problems

This section describes how to determine whether your target system is 
causing problems with the operation of the emulation module.

What to check first

1 Try some basic built-in commands (using the Command Line 
window or a serial or telnet connection):

U>rst
R>

This should reset the target and display an “R>” prompt.

R>b
M>

This should stop the target and display an “M>” prompt.

M>reg r1
reg r1=00000000

M>

This should read the value of the r1 register (the value will probably be 
different on your target system).

M>m 0..
00000000 7c3043a6 7c2802a6 7c3143a6 4bf04111
00000010 00000000 00000000 00000000 00000000
00000020 00000000 00000000 00000000 00000000
00000030 00000000 00000000 00000000 00000000
00000040 00000000 00000000 00000000 00000000
00000050 00000000 00000000 00000000 00000000
00000060 00000000 00000000 00000000 00000000
00000070 00000000 00000000 00000000 00000000

M>

This should display memory values starting at address 0.

M>s

This should execute one instruction at the current program counter.
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NOTE: Note that stepping can fail if memory at the current PC does not contain a 
valid instruction.

If any of these commands don’t work, there may be a problem with the 
design of your target system, a problem with the revision of the 
processor you are using, or a problem with the configuration of the 
emulation module.

2 Check that the emulation module firmware matches your 
processor. To do this, enter:

M>ver

See Also “Built-In Commands” on page 125 for information on entering built-in 
commands.

To interpret the initial prompt

The initial prompt can be used to diagnose several common problems. 
To get the most information from the prompt, follow this procedure:

1 Connect the emulation probe/module to your target system.

2 Set the default configuration settings. Enter:

M>init -c

You can enter this command at any prompt. The emulation module will 
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respond with the same information as printed by the “ver” command.

Now you can do some more tests:

3 Enter the reset command:

U>rst
R>

The “R>” prompt is a good response that indicates SRESET and 
HRESET are working.

If interrupts are non-recoverable

❏ Check that interrupt service routines (ISRs) in the target code 
meet the requirements listed in the PowerPC documentation.

For proper debugging in ISRs, the PowerPC documentation specifies 
that the exception handlers must do the following:

• As an epilogue to the ISR:

• Save the SRR0, SRR1, DAR, DSISR registers.

• Set the RI bit in the MSR (Machine State Register.Recoverable 
Interrupt Bit).

• As a prologue to the ISR:

If the response is “!ERROR 905! 
Driver firmware is incompatible 
with ID of attached device”

Make sure the target interface 
module is connected to the cable of 
the emulation module, then try the 
“init -c” command again.

If the initial prompt is “p>” Check pin 9 on header, 3.3V (VOD).

If the initial prompt is “M>” The processor entered debug mode 
without the help of the emulation 
module. Is another debugger 
connected?

If the initial prompt is “U>” The emulation module is scanning 
the instruction register correctly.
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• Restore the SRR0, SRR1, DAR, DSISR registers.

• Issue an RFI (Return from Interrupt) instruction.

Upon entering the ISR, the processor clears the MSR.RI bit, and copies 
the IP (Instruction Pointer)->SRR0 and the MSR->SRR1. The SRR0 
and SRR1 are the save and restore registers. These contain the 
information needed to return to the state prior to the interrupt.

The RI bit will prevent the processor from breaking into debug mode 
with a maskable debug port breakpoint. A non-maskable breakpoint is 
required to break the processor when the RI bit is cleared, resulting in 
a possible non-recoverable state.

Software breakpoints place a “Trap” instruction into the breakpoint 
address. If the trap instruction is executed within an ISR, a break to 
background mode will occur. This causes the SRR0 and SRR1 registers 
to be written over, causing a non-recoverable state. If the exception 
handler saves these registers, and sets the MSR.RI bit, the software 
breakpoint will always be recoverable.

If hardware breakpoints have no effect

Hardware breakpoints by default will not break the processor if they 
are set within an exception handler which has not saved the SRR’s and 
set the MSR.RI bit. However, these can quite easily be reprogrammed 
to assert a non-maskable break. Note that the breakpoint will halt the 
processor, but will cause a non-recoverable state.

To reprogram the hardware breakpoint to assert a non-maskable break:

M>bc -e hwbp
M>reg lctrl2

reg lctrl2=02018000
M>reg lctrl2=02018800 # OR in 0x00000800 with previous value

Hardware breakpoints will now cause a non-maskable break, which will 
halt the processor regardless of the status of the MSR.RI bit. Again, 
note that in this case the break will be non-recoverable if the exception 
handler has not saved the SRR’s.
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If the target resets itself

The most common plug-in issue is the target resetting itself. If the PC is 
set to some initial location, and then a short time later, the PC=100 or 
PC=fff00100, the target is resetting itself. In most cases, the chip is 
causing the reset, not the target hardware.

There are a number of possible causes of the reset. To determine the 
cause of reset, read the RSR (Reset Status Register):

M>m -a2 -d2 288@reg # telnet command which reads the RSR

The bits in this register show the cause of the reset:

To clear the RSR, execute the following:

M>m -a2 -d2 288@reg=ffff

If running from reset causes problems

Running from reset may cause some problems once background is 
entered. To ensure proper operation, the DER register must have bits 

565�%LW�(QFRGLQJ

%LW &DXVH�RI�UHVHW ([SODQDWLRQ

���06%� ([WHUQDO�+DUG�5HVHW 7KH�HPXODWLRQ�PRGXOH�DFWXDOO\�XVHV�DQ�H[WHUQDO�UHVHW�ZKHQ�
UHVHWWLQJ�WKH�WDUJHW�� ([WHUQDO�6RIW�5HVHW

� /RVV�RI�/RFN &DXVHG�ZKHQ�WKH�3//�ORVHV�WKH�SKDVH�ORFN�RQ�WKH�H[WHUQDO�FORFN�
VRXUFH�

� 6:�:DWFKGRJ 0DNH�VXUH�WKH�6<3&5�UHJLVWHU�GLVDEOHV�WKH�ZDWFKGRJ�WLPHU�
5!UHJ�FIBV\SFU IIIIII���RU
0!P��D���G���#UHJ IIIIII��

� &KHFNVWRS 2FFXUV�ZKHQ�WKH�SURFHVVRU�HQWHUV�D�FKHFNVWRS�VWDWH�

� 'HEXJ�3RUW�+DUG�5HVHW

� 'HEXJ�3RUW�6RIW�5HVHW

� -7$*�5HVHW
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31,30,29,28 set (0x0000000f), and the SYPCR register must have the 
“Disable watchdog freeze” bit set (0x00000080).

If you see the “!ASYNC_STAT 173!” error 
message

If after a break, the following error arises:

!ASYNC_STAT 173! MSR.RI bit not set - Break may not be recoverable

This indicates that the MSR.RI bit is not set, implying that a non-
maskable break was needed, and the interrupt may not be recoverable. 
If this occurs while breaking out of regular code, then the MSR.RI bit 
was not set in the boot code. This can be fixed by “ORing” in 
0x00000002 into the SRR1 register and resuming the run.

If there are problems with the debug port 
signals

❏ Check for pull-down resistors on DSDI and DSCK.

Some target systems may have 220 ohm pull-downs on these two 
signals. These signals are series terminated by the analysis probe or 
TIM with a 46 ohm resistor. A 220 ohm pull-down would present a 20% 
drop in signal level when driven high, which could easily cause some 
malfunctions. There should be a very weak pull-down on the target, if 
any at all. If you want to pull-down DSCK, use a value of 2.2K or 
greater.

To test the target system

The following program can be placed into memory.

start: addi r1,1 - 0x38210001
nop - 0x60000000
nop - 0x60000000
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bra start - 0x4bfffff4

The opcode 0x4bfffff4 is a branch to a relative offset, so this program 
can be placed at any start address.

M>reg r1=0
M>m -a2 -d2 10000=3821,1,6000,0,6000,0,4bff,fff4
M>r 10000
U>reg r1

reg r1=00034567 # or some number
U>reg r1

reg r1=00102333 # or some number
U>

This program will loop forever, incrementing r1. This is a good test 
program to load once a memory system is up to make sure the 
microprocessor can run code out of memory.
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Solving Emulation Probe Problems

To run the power up self test

1 Unplug the emulation probe, then plug it in.

2 Watch the status lights. They should show the following pattern:

❍ = LED is off
● = LED is on
✳ = Not applicable (LED is off or on)
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If the power up self test fails, the RESET LED will flash the number of 
the test, then stay lit.

If any of the LEDs fail to change, or all of them remain on, there is a 
system failure.

1RUPDO�VHTXHQFH�GXULQJ�SRZHU�XS�VHOI�WHVW

3ZU�7DUJHW�
/('V 0HDQLQJ

� ❍●

❍❍
,QLWLDO�SRZHU�XS��V\VWHP�UHVHW

� ❍●

❍❍
;,/,1;�DUUD\�LQLWLDOL]HG�VXFFHVVIXOO\

� ❍●

●❍
;,/,1;�DUUD\�WHVWHG�VXFFHVVIXOO\

� ●●

❍❍
%227�520�VSDFH�WHVWHG�VXFFHVVIXOO\

� ❍●

●❍
*(1(5,&�520�VSDFH�WHVWHG�VXFFHVVIXOO\

� ●●

❍❍
'5,9(5�520�VSDFH�WHVWHG�VXFFHVVIXOO\

� ❍●

●❍
5(6(59('�520�VSDFH�WHVWHG�VXFFHVVIXOO\

� ●●

❍❍
5$0�WHVWHG�VXFFHVVIXOO\

� ❍●

●❍
/$1�LQWHUQDO�IHHGEDFN�WHVWHG�VXFFHVVIXOO\

�� ❍●

❍❍
%RXQGDU\�VFDQ�PDVWHU��%60��WHVW�EHJXQ

�� ●●

●❍
%06�WHVW�FRPSOHWHG��VWDUW�V\VWHP��ORDG�GULYHUV��LQLWLDOL]H�/$1
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Following power up, the LEDs will enter one of the following states: 

Starting a user interface will change the pattern to the one requested 
by the interface.

If the power up self tests fail, try the following:

❏ Check and reset the LAN address. LAN powerup failures will 
occur if the emulation probe does not have a valid link-level 
address and IP address.

❏ Disconnect all external connections, including the LAN, serial 
(RS-232), and BNC break and trigger cables, then cycle power.

❏ To ensure that the firmware is working as it should, reprogram 
the firmware, then cycle power.

To run the performance verification tests

In addition to the powerup tests, there are several additional 
performance verification (PV) tests available.

Some of these tests can be performed through the HP 16700A/16700A-

3ZU�7DUJHW�
/('V 0HDQLQJ

❍●

❍❍
1R�WDUJHW�V\VWHP�SRZHU��RU�WKH�HPXODWLRQ�SUREH�LV�QRW�FRQQHFWHG�WR�WKH�WDUJHW�V\VWHP��
RU�UHPRYH

❍●

❍●
7DUJHW�V\VWHP�LV�LQ�D�UHVHW�VWDWH

❍●

●❍
7DUJHW�SURFHVVRU�LV�H[HFXWLQJ�XVHU�FRGH

●●

●●
7DUJHW�SURFHVVRU�LV�LQ�DQ�XQNQRZQ�VWDWH

●●

❍❍
7DUJHW�SURFHVVRU�LV�LQ�GHEXJ�PRGH

●●

●❍
2QO\�WKH�ERRW�520�ZDV�XVHG��RWKHU�ILUPZDUH�LQ�WKH�)ODVK�(3520�KDV�EHHQ�FRUUXSWHG
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series logic analysis system. The LAN tests for an emulation probe can 
only be executed through the RS-232 port.

To fully test the emulation probe, you will need to run the PV test with 
several hardware configurations:

• For the BREAK IN, TRIGGER OUT BNC FEEDBACK TEST, connect a 
coaxial cable between BREAK IN and TRIGGER OUT. 

To run the performance verification tests using 
the logic analysis system

1 End any Emulation Control Interface or debugger sessions.

2 Disconnect the 50-pin cable from the emulation probe, and plug 
the loopback test board (HP part number E3496-66502) into the 
emulation probe.

3 In the system window, click the emulation probe and select 
Performance Verification.

4 Click Start PV.

The results will appear on screen.

To run complete performance verification tests 
for an emulation probe

The LAN tests can only be executed through the RS-232 port. The 
remainder of this section assumes that the tests are being run from a 
terminal emulator connected to the RS-232 port. 

1 Disconnect the 50-pin cable from the emulation probe, and plug 
the emulator loopback test board (HP part number E3496-
66502) directly into the emulator. Do not plug anything into the 
other end of the emulator loopback test board.
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On a good system, the RESET LED will light and the BKG and USER 
LEDs will be out.

2 Connect a coaxial cable between BREAK IN and TRIGGER OUT. 

3 Set all of the switches to CLOSED.

This is standard RS-232 at 9600 baud which can be connected directly 
to a 9 pin RS-232 interface that conforms to the IBM PC-AT 9 pin 
standard.

4 Use a terminal emulator to connect to the emulation probe.

5 Enter the pv 1 command.

See Also Options available for the “pv” command are explained in the help 
screen displayed by typing “help pv” or “? pv” at the prompt. 

([DPSOHV Here are some examples of ways to use the pv command.

To execute both tests one time:

pv 1

To execute test 2 with maximum debug output repeatedly until a Ctrl-c 
is entered:

pv -t2 -v9 0
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To execute tests 3, 4, and 5 only for 2 cycles:

pv -t3-5 2

The results on a good system, with the BNCs connected, and with the 
loopback test board connected, are as follows: 

c>pv 1
Testing: HPE3499B Series Emulation System passed!

Test # 1: Powerup PV Results passed!
Test # 2: LAN 10Base2 Feedback Test passed!
Test # 3: LAN 10BaseT Feedback Test passed!
Test # 4: Break In and Trigger Out BNC Feedback Test passed!
Test # 5: Target Probe Feedback Test passed!
Test # 6: Boundary Scan Master Test passed!
Test # 7: 12C Test passed!
Test # 8: Data Lines Test passed!

PASSED Number of tests: 1 Number of failures: 0

Copyright (c) Hewlett-Packard Co. 1987
All Rights Reserved.  Reproduction, adaptation, or translation without prior 
written permission is prohibited, except as allowed under copyright laws.

HPE3499B Series Emulation System
Version:   A.07.53 01Mar98
Location:  Generics

HPE3459A ARM7 JTAG Emulator
Version:   A.01.01 01Mar98

R>

If a performance verification test fails

There are some things you can do if a failure is found on one of these 
tests. Details of the failure can be obtained through using a verbose 
level of 2 or more.

TEST 2: LAN 10BASE2 Feedback Test failed

For LAN 10BASE2 test, the following is an example of a failure which is 
not caused by a broken emulator.

R>pv -t2 -v2 1

Testing: HPE3499B Series Emulation System
Test # 2: LAN 10Base2 Feedback Test failed!

FAILED - no lan connection (LAN probably not terminated
FAILED  Number of tests: 1 Number of failures: 1

,I�WKH�SDUWLFXODU�IDLOXUH�\RX�VHH�LV�QRW�OLVWHG�EHORZ��FRQWDFW�+3�IRU�DVVLVWDQFH�
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Check to see that the port under test has a good cable connected to it 
and that the cable is properly terminated with a 50 ohm terminator on 
each end of the overall cable.

R>pv -t2 -v2 1

Testing: HPE3499B Series Emulation System
Test # 2: LAN 10Base2 Feedback Test failed!

FAILED due to excessive collisions
FAILED Number of tests: 1 Number of failures: 1

The most common cause of this problem is poor termination of the 
cable or failure to remove the port under test from the LAN before 
performing the test. Check to see that the terminators are good (50 
ohms) and that you are isolated from any traffic on a system LAN.

R>pv -t2 -v2 1

Testing: HPE3499B Series Emulation System
Test # 2: LAN 10Base2 Feedback Test failed!

FAILED - invalid Ethernet address in EEPROM
FAILED Number of tests: 1 Number of failures: 1

First check to see that a correct link-level address and IP address have 
been set in the virtual EEPROM through the “lan” command. If the 
“lan” command shows bad information for the link-level address and IP, 
then try to set them to correct values. If you are unable to set them to 
correct values, their is a failure in the FLASH ROM which requires 
service from HP.

Test 3: 10BaseT Feedback Test failed here

R>pv -t3 -v2 1

Testing: HPE3499B Series Emulation System
Test # 3: LAN 10BaseT Feedback Test failed!

FAILED Number of tests: 1 Number of failures: 1

In addition to the internal checks performed in Test 2, this test also 
checks for shorts on the cable connected to the network. If this test 
fails, disconnect the cable and run the test again. If it then passes, the 
cable is faulty. If it still fails, it requires service from HP.

If the emulator passes this “pv” test, additional testing can be 
performed through exercising the connection to the network. To run 
this test, set configuration switch 1 and switch 5 to OPEN, all other 
configuration switches CLOSED (this enables LAN using 10BaseT). 
Cycle power and wait for 15 to 30 seconds. Then “ping” the emulator 
from your host computer or PC. See the LAN documentation for your 
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host computer for the location and action of the “ping” utility. If the 
emulator fails to respond to the “ping” request, verify that the LAN 
parameters (IP address and gateway address) are set correctly and 
that your host computer recognizes the IP address of the emulator. If 
all else is good, then failure to respond to ping indicates a faulty 
emulator.

Test 4:   Break In and Trigger Out BNC Feedback Test 

R>pv -t4 -v2 1 

Testing: HPE3499B Series Emulation System
Test # 4: Break In and Trigger Out BNC Feedback Test failed!

Break In not receiving Break Out HIGH
FAILED Number of tests: 1 Number of failures: 1

Before returning to HP, check to ensure that you have connected a 
good Coaxial cable between the two BNCs. If the cable is good, the 
emulator is bad. 

TEST 5: Target Probe Feedback Test

TEST 6: Boundary Scan Master Test 

TEST 7: I2C Test 

TEST 8: Data Line Test

If these tests are not executed, check that you have connected the 
emulator loopback test board.

If these tests fail, return the emulator to HP for replacement.
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Solving Emulation Module Problems

Occasionally you may suspect a hardware problem with the emulation 
module or target interface module. The procedures in this section 
describe how to test the hardware, and if a problem is found, how to 
repair or replace the broken component.

NOTE: The emulation module uses the HP 16600A/16700A-series logic analysis 
system’s LAN interface. If you are having LAN-related problems with the 
emulation module, refer to the logic analysis system’s on-line help.

To run the performance verification tests using 
the logic analysis system

1 End any Emulation Control Interface or debugger sessions.

2 Disconnect the 50-pin cable from the emulation module, and plug 
the loopback test board (HP part number E3496-66502) into the 
emulation module.

3 In the system window, click the emulation module and select 
Performance Verification.
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4 Click Start PV.

The results will appear on screen.

To run complete performance verification tests 
using a telnet connection

1 Disconnect the 50-pin cable from the emulation module, and plug 
the loopback test board (HP part number E3496-66502) directly 
into the emulation module. Do not plug anything into the other 
end of the loopback test board.

On a good system, the RESET LED will light and the BKG and USER 
LEDs will be out.

2 telnet to the emulation module.

3 Enter the pv 1 command.

See Also Options available for the “pv” command are explained in the help 
screen displayed by typing “help pv” or “? pv” at the prompt. Note, 
however, that some of the options listed may not apply to your 
emulation module.

([DPSOHV If you are using a UNIX system, to telnet to a logic analysis system 
named “mylogic”, enter:

telnet mylogic 6472

Here are some examples of ways to use the pv command.

To execute both tests one time:

pv 1

To execute test 2 with maximum debug output repeatedly until a Ctrl-c 
is entered:

pv -t2 -v9 0

To execute tests 3, 4, and 5 only for 2 cycles:

pv -t3-5 2
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The results on a good system with the loopback test board connected, 
are as follows:

M>pv 1

Testing: HPE3499C Series Emulation System
Test 1: Powerup PV Results Passed!
Test 2: Target Probe Feedback Test Passed!
Test 3: Boundary Scan Master Test Passed!
Test 4: I2C Test Passed!
Test 5: Data Lines Test Passed!

PASSED Number of tests: 1 Number of failures: 0

Copyright (c) Hewlett-Packard Co. 1987
All Rights Reserved. Reproduction, adaptation, or translation without prior
written permission is prohibited, except as allowed under copyright laws.

HPE3499C Series Emulation System
Version A.07.51 17Dec97
Location: Generics

HPE3497A Motorola MPC800 Embedded PowerPC Emulator
Version: A.01.02 18Dec97

M>

You may get an error like “!ERROR 172! Bad status code (0xff) from 
the hard reset sequence” just before the prompt. This is because the 
self-test loopback connector is installed instead of being connected to a 
real PowerPC target system. You may also get a “?>” prompt for the 
same reason, and this is normal and expected. Any errors after the 
“PASSED Number of tests: 1 Number of failures: 0” line can be ignored.

If a performance verification test fails

There are some things you can do if a failure is found on one of these 
tests. Details of the failure can be obtained through using a -v option 
(“verbose” level) of 2 or more.

TEST 5: Target Probe Feedback Test

A verbose output on this test can be extensive. For example, the 
following is the output of this test if you forget to plug in the loopback 
test board.

,I�WKH�SDUWLFXODU�IDLOXUH�\RX�VHH�LV�QRW�OLVWHG�EHORZ��FRQWDFW�+3�IRU�DVVLVWDQFH�
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p>pv -t5 -v2 1

Testing: HPE3499A Series Emulation System
Test # 5: Target Probe Feedback Test failed!

Bad 20 Pin Status Read when unconnected = 0x7fb7
Expected Value = 0xffb7

Bad 20 Pin Status Read when connected = 7fb7
Expected Value = 0x7fb7

Output 19 Low not received on Input 11
Output 11 Low not received on Input 19
Output 13 Low not received on Input 1
Output 12 High not received on Input 6
Output 12 and Input 6 not pulled high on release
Output 8 Low not received on Input 10
Output 7 Low not received on Input 20
Output 4 Low not received on Input 14
Output 2 Low not received on Input 18

FAILED Number of tests: 1 Number of failures: 1

If the you get a verbose output like this, check to make sure that the 
loopback test board was connected properly.

TEST 6: Boundary Scan Master Test

TEST 7: I2C Test

If these tests are not executed, check that you have connected the 
loopback test board.

If these tests fail, return the emulation module to HP for replacement.
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Emulation Probe Electrical Specifications

BNC, labeled TRIGGER OUT

Output Drive. Logic high level with 50-ohm load >= 2.0 V. Logic low 
level with 50-ohm load <= 0.4 V. Output function is selectable.

BNC, labeled BREAK IN

Input. Edge-triggered TTL level input (active high), 20 pf, with 2K 
ohms to ground in parallel. Maximum input: 5 V above VCC; 5 V below 
ground. Input function is selectable. The BNC introduces 
approximately 2.5 ms skid after break-in at 25 MHz.

Communications

Serial Port. 9-pin female type “D” subminiature connector. RS-232 
DCE to 115.2 kbaud.

10BASE-T LAN Port. RJ-45 connector. IEEE 802.3 10BASE-T 
(StarLAN).

10BASE 2 LAN Port. 50-ohm BNC connector. IEEE 802.3 10BASE2 
(ThinLAN). When using this connector, the processor probe provides 
the functional equivalent of a Medium Attachment Unit (MAU) for 
ThinLAN.

Accessory Power Out

12 V, 3.0A, center negative

Power Supply

Input. 100-240 V, 1.0 A, 50/60 Hz, IEC 320 connector.

Output. 12 V, 3.3 A
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Emulation Probe Operating/Environmental 
Characteristics

The following operating characteristics are not specifications, but are 
typical operating characteristics for the HP E3456A emulation probe 
and MPC505/509/555 target interface module.

2SHUDWLQJ�&KDUDFWHULVWLFV
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)RU�LQGRRU�XVH�RQO\�

(QYLURQPHQWDO�&KDUDFWHULVWLFV

7HPSHUDWXUH 2SHUDWLQJ����WR������&������WR�������)�
1RQRSHUDWLQJ������WR������&������WR�������)��
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5HODWLYH�+XPLGLW\ ����WR�����
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Emulation Probe/Module Electrical 
Characteristics

Emulation Module Operating Characteristics

The following operating characteristics are not specifications, but are 
typical operating characteristics for the HP 16610A emulation module 
and MPC505/509/555 target interface module.

0D[LPXP�5DWLQJV
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To return a part to Hewlett-Packard for service

1 Follow the procedures in the “Solving Problems” chapter on 
page 117 to make sure that the problem is caused by a hardware 
failure, not by configuration or cabling problems.

2 In the U.S., call 1-800-403-0801. Outside the U.S., call your 
nearest HP sales office. Ask them for the address of the nearest 
HP service center.

3 Package the part and send it to the HP service center.

Keep any parts which you know are working. For example, if only the 
target interface module is broken, keep the emulation module and 
cables.

4 When the part has been replaced, it will be sent back to you.

The unit returned to you will have the same serial number as the unit 
you sent to HP.

The HP service center can also troubleshoot the hardware and replace 
the failed part. To do this, send your entire measurement system to the 
service center, including the logic analysis system, target interface 
module, and cables.

In some parts of the world, on-site repair service is available. Ask an HP 
sales or service representative for details.

To get replacement parts

The repair strategy for the emulation probe/module is board 
replacement. However, the following tables list some mechanical parts 
that may be replaced if they are damaged or lost. Contact your nearest 
Hewlett-Packard Sales Office for further information.

Exchange assemblies are available when a repairable assembly is 
152   



Chapter 8: Service Information
returned to Hewlett-Packard. These assemblies have been set up on 
the “Exchange Assembly” program. This allows you to exchange a 
faulty assembly with one that has been repaired, calibrated, and 
performance verified by the factory. The cost is significantly less than 
that of a new assembly.

These part numbers are subject to change without notice.
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To clean the instrument

If the instrument requires cleaning:

1 Remove power from the instrument.

2 Clean the instrument with a mild detergent and water.

3 Make sure that the instrument is completely dry before 
reconnecting it to a power source.
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Glossary
A

analysis probe A probing solution 
connected to the target 
microprocessor. It provides an inter-
face between the signals of the target 
microprocessor and the inputs of the 
logic analyzer. Formerly called a 
“preprocessor.”

D

debug port A hardware interface 
designed into a microprocessor that 
allows developers to control 
microprocessor execution, set 
breakpoints, and access 
microprocessor registers or target 
system memory using a tool like the 
emulation probe.

development port See debug port.

E

elastomeric probe adapter A 
connector that is fastened on top of a 
target microprocessor using a 
retainer and knurled nut. The 
conductive elastomer on the bottom 
of the probe adapter makes contact 
with pins of the target 
microprocessor and delivers their 
signals to connection points on top of 
the probe adapter.
 

emulation module An emulation 
module is installed within the 
mainframe of a logic analyzer. It 
provides run control within an 
emulation and analysis test setup. 
See also emulation probe.

emulation probe An emulation 
probe is a stand-alone instrument 
connected via LAN to the mainframe 
of a logic analyzer or to a host 
computer. It provides run control 
within an emulation and analysis test 
setup. Formerly called a “processor 
probe” or “software probe.” See also 
emulation module.

extender A part whose only function 
is to provide connections from one 
location to another. One or more 
extenders might be stacked to raise a 
probe above a target microprocessor 
to avoid mechanical contact with 
other components installed close to 
the target microprocessor. 
Sometimes called a “connector 
board.”

F

flexible adapter Two connection 
devices coupled with a flexible cable. 
Used for connecting probing 
hardware on the target 
microprocessor to the analysis probe.
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G

general-purpose flexible adapter 

A cable assembly that connects the 
signals from an elastomeric probe 
adapter to an analysis probe. 
Normally, a male-to-male header or 
transition board makes the 
connections from the general-
purpose flexible adapter to the 
analysis probe.

H

high-density adapter cable A 
cable assembly that delivers signals 
from an analysis probe hardware 
interface to the logic analyzer pod 
cables. A high-density adapter cable 
has a single Mictor connector that is 
installed into the analysis probe, and 
two cables that are connected to 
corresponding odd and even logic 
analyzer pod cables.

high-density termination adapter 

cable Same as a high-density 

adapter cable, except it has a 
termination in the Mictor connector.

J

jumper Moveable direct electrical 
connection between two points.
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mainframe logic analyzer A logic 
analyzer that resides on one or more 
board assemblies installed in an 
HP 16500, HP 1660-series, or 
HP 16600A/700A-series mainframe.

male-to-male header A board 
assembly that makes point-to-point 
connections between the female pins 
of a flexible adapter or transition 
board and the female pins of an 
analysis probe.

P

preprocessor See analysis probe.

pod A collection of logic analyzer 
channels associated with a single 
cable and connector.

preprocessor interface See 
analysis probe.

probe adapter See elastomeric 

probe adapter.

processor probe See emulation 

probe.

prototype analyzer The 
HP 16505A prototype analyzer acts 
as an analysis and display processor 
for the HP 16500B/C logic analysis 
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system. It provides a windowed 
interface and powerful analysis 
capabilities. Replaced by HP 16600A/
16700A-series logic analysis systems.

R

run control probe See emulation 

probe and emulation module.

S

Setup Assistant A software 
program that guides a user through 
the process of connecting and 
configuring a logic analyzer to make 
measurements on a specific 
microprocessor.

shunt connector See jumper.

software probe See emulation 

probe.

solution HP’s term for a set of tools 
for debugging your target system. A 
solution includes probing, inverse 
assembly, the HP B4620B source 
correlation tool set, and an emulation 
module.

stand-alone logic analyzer A 
stand-alone logic analyzer has a pre-
defined set of hardware components 
which provide a specific set of 
capabilities. It is designed to perform 
 

logic analysis. A stand-alone logic 
analyzer differs from a mainframe 
logic analyzer in that it does not offer 
card slots for installation of additional 
capabilities, and its specifications are 
not modified based upon selection 
from a set of optional hardware 
boards that might be installed within 
its frame.

T

target control port An 8-bit, TTL 
port on a logic analysis system that 
you can use to send signals to your 
target system. It does not function 
like a pattern generator or emulation 
module, but more like a remote 
control for the target’s switches.

target interface module (TIM) A 
small circuit board which connects 
the 50-pin cable from an emulation 
module or emulation probe to signals 
from the debug port on a target 
system.

TIM See target interface module.

trigger specification A set of 
conditions that must be true before 
the instrument triggers. See the 
printed or on-line documentation for 
your logic analyzer for details.

transition board A board assembly 
that obtains signals connected to one 
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side and rearranges them in a 
different order for delivery at the 
other side of the board.

1

1/4-flexible adapter An adapter 
that obtains one-quarter of the 
signals from an elastomeric probe 
adapter (one side of a target micro-
processor) and makes them available 
for probing.
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Index
Symbols

!ASYNC_STAT 173!, 133
!ERROR 905!, 130
/etc/bootptab, 26
/etc/inetd.conf, 26
/etc/services, 26

Numerics

1/4-flexible adapter, 158
10BASE 2 LAN port, 148
10BASE-T LAN port, 33, 148

configuration switches, 28
10-pin ribbon cable, 16, 46
50-pin ribbon cable, 16, 46

A

accessory power out, 148
additional equipment required, 47
additional software required, 47
address, IP, 22
altitude, 149
analysis probe, 155

connection, 71
ASCII terminal, 23
assembly code, 106
assistant

See Setup Assistant

B

b, terminal interface command, 126
baud rate, 35
BDM communication speed, 82
BDM connector, 65, 69
BDM signals, 65
Berg connector, 65
BKG LED, 139, 144
BNC break type, 86
BOOTP, 22, 26

daemon, 26
database file, 26
server, 21
 

BREAK IN, 148
breakpoints, 2, 90, 115

clearing, 106
setting, 106

built-in commands, 79, 125, 126
LAN configuration, 23

C

cable
LAN, 28
serial, 35

capacitance added, 64
CD-ROM, installing software from, 

54
cf, terminal interface command, 

126
changing the port number, 60
characteristics, 147
checkstop, 132
cleaning the instrument, 154
clock speed, processor, 82
commands, emulation probe/

module, 77
comments on the documentation, 4
communication with target, 

verifying, 73
configuration options, 81
configuring the emulation probe/

module, 75
connecting

target system, 63
connection

serial port, 38
target system, 69

cu terminal emulator, 36

D

DCE device, 39
DCE or DTE selection and RS-232 

cable, 38
debug port, 2, 155

connection, 64, 83
connector, 2, 17, 69
hard reset, 132
soft reset, 132

debug port connector, 69
debugger, 2, 17, 47, 77

connections, port numbers, 60
documentation, 4
interface, 80
preparing for, 59
tasks, performing common, 99,

106
using, 89

DER register, 132
development port, 2

See debug port, 155
download performance, 114
download, fast, 68
DSCK signal, 64, 65, 133
DSDI signal, 64, 65, 133
DSDO signal, 65

E

E3497-66502 TIM, 65, 66, 67
E3497-66503 TIM, 65, 67
elastomeric probe adapter, 155
electrical characteristics, 

emulation probe/module, 150
electrical specifications, emulation 

probe, 148
electrostatic discharge, 48
email address for comments, 4
Emulation Control Interface, 2, 16, 

17, 46, 47, 54, 56, 77, 92
emulation module, 3, 155

configuring, 75
electrical characteristics, 150
exchange assemblies, 153
firmware, 54
firmware, updating, 56
installing, 43
operating characteristics, 150
personality, 56
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problems, common, 120
problems, solving, 143
prompts, 127
replaceable parts, 153
reset status, 127
status lights, 124
testing, 53

emulation probe, 3, 155
configuring, 75
electrical characteristics, 150
electrical specifications, 148
environmental characteristics,

149
exchange assemblies, 153
firmware, updating, 40
installing, 13
LAN connection, 21
LAN LEDs, 123
operating characteristics, 149
problems, common, 119
problems, solving, 135
prompts, 127
replaceable parts, 153
reset status, 127
status lights, 121
target/power LEDs, 122

emulator probe
powering on/off, 19
serial port, 34

environmental characteristics
emulation module, 150
emulation probe, 149

equipment, 16, 46
supplied, 16, 46

error conditions, debugger, 101, 
108

ethernet address, 24
exchange assemblies, 152
extender, 155
external hard reset, 132
external reset configuration word, 

84
external soft reset, 132
160
F

fast download, 68
firmware, 46

emulation module, 54, 55
emulation probe, 32, 40
version, 40, 56

firmware (emulation module), 
updating, 56

flash support, 68
flexible adapter, 155
flow control, 34
FRZ signal, 65

G

gateway address, 21, 22, 23, 24, 
31, 32, 59

general-purpose flexible adapter, 
156

glossary, 155
GND signal, 65, 66, 67
Green Hills debugger, 95

H

hardware breakpoints, 115, 131
hardware handshaking, 35
help, terminal interface command, 

126
high-density adapter, 156
hostname, 22, 23, 59
HP 16600A/16700A-series logic 

analysis system, 3, 18, 47
HP 16600A-series logic analysis 

system, 51
HP 16610A emulation module, 2, 

46
HP 16700A-series logic analysis 

system, 48
HP 16701A expansion frame, 48
HP C2932A modem cable, 35
HP E2490A analysis probe, 2, 18
HP E3456A emulation probe, 2, 

149
HP E3497-66503 TIM, 4
HP service center, 152
hpserv, 95
HP-UX operating system, 21
HRESET signal, 65, 66, 67
HyperTerminal application in MS 

Windows 95/NT, 36

I

IEEE 802.3 10BASE2, 21, 148
IEEE 802.3 10BASE-T, 21, 148
INCLUDE file, 106
init, terminal interface command, 

126
initialization script, 98
installing software, 54, 55
installing the emulation module, 43
installing the emulation probe, 13
integer dot notation, 22
internal reset configuration word, 

84
internet address, 22
interrupt service routines, 84, 130
IP address, 21, 22, 23, 24, 31, 32, 

59
IWP0/VFLS0 signal, 66
IWP1/VFLS1 signal, 66

J

JTAG reset, 132
jumper, 156

K

kermit terminal emulator, 36

L

lan command, 23
LAN communication

problems, solving, 31
verifying, 29, 61
 



Index
LAN connection problems, 32, 140, 
141

LAN parameters, 21
BOOTP, configuring, 26
terminal interface, configuring,

23
lan, terminal interface command, 

126
licensing software, 55
link beat integrity, 29
LINK LED, 123
link-level address, 22, 23, 24, 27
local area network (LAN), 17, 59
logic analysis system, installing 

emulation module, 48
loopback test board, 16, 46, 138, 

143
loss of lock, 132

M

m, terminal interface command, 
126

mainframe logic analyzer, 156
male-to-male header, 156
mask, subnet, 33
maskable break, 84, 86
Medium Attachment Unit (MAU), 

21, 148
memory accesses, testing, 87
microprocessor compatibility, 149
Microtec Research debugger, 103
MIOS1TPCR register, 66
MPC505/509 debug port 

connector, 65
MPC555 debug port connector

option 1, 65
option 2, 66
option 3, 67

MULTI Development Environment, 
95

Multiplication Factor, 82
 

N

network parameters, 22
non-maskable break, 84, 86

O

on/off switch, 19
on-chip flash support, 68
on-line help, 4
operating characteristics

emulation module, 150
emulation probe, 149

operating system, 54
options, configuration, 81

P

parts, returning, 152
performance verification tests, 21, 

137, 138, 143
personality, emulation module, 56
ping command, 32
pod, 156
POL LED, 33, 123
polarity (10BASE-T), reversed, 

123
port number, 22, 24, 59, 60, 93, 

125
changing, 60

power light, 20
power on/off sequence, 19
power supply, 19, 148

cord, 20
power up self test, 135
powering-on/off the emulator 

probe, 19
power-on self test, 31, 135
preparing for a debugger, 59
preprocessor

See analysis probe

preprocessor interface
See analysis probe

probe adapter
See elastomeric probe adapter
problems, RS-232, 38
processor clock speed, 82
processor probe, 90

See emulation probe

processor support package, 54, 57
processor type, 81
products, 4
program symbols, loading, 107
program trace signals, 65, 66
prototype analyzer, 156
pull-down resistors, 133
PWR LED, 122

R

r, terminal interface command, 126
readme file, 41, 64
real-time runs, restrict to, 86
reg, terminal interface command, 

126
registers, displaying, 106
relative humidity, 149
release notes, 64
removing software, 55
rep, terminal interface command, 

126
replacement parts, 152
requirements, 16, 46

target system, 64
reset configuration word, 84
RESET LED, 122, 136, 139, 144
reset processor clock speed, 82
RESET signal, 64, 65
restrict to real-time runs, 86
returning parts, 152
ROM code, 115
RS-232 cable, 35
RSR register, 132
rst, terminal interface command, 

126
run control probe

See emulation module

See emulation probe
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Run Control window, 73
RUN LED, 122
running from reset, 132
running in background monitor 

status, 127
running user program status, 127
RX LED, 123

S

s, terminal interface command, 126
SCCR register, 82
self test, 135
serial cable, 34, 35

pinout, 36
serial communication

configuration switches, 34
problems, solving, 38
verifying, 36

serial connection
DCE or DTE selection, 38
number of connections, 38
problems, 38
setting up, 34
verifying, 36

serial device file, 34
serial interface, 23
serial port, 21, 34, 148
service information, 151
service ports, 24
Setup Assistant, 57, 157
SGPIO6/FRZ/PTR* signal, 67
shunt connector

See jumper

single-step, 90, 106
SingleStep debugger, 110
SIUMCR register, 67
slot 1, 50
Slow clock, 120
Slow or missing clock, 119, 120
software breakpoints, 115, 131
Software Development Systems 

debugger, 110
162
software probe, 90
See emulation probe

software supplied, 16, 46
software, installing, 54
Solaris operating system, 21
solution, 157
solving problems, 117

emulation module, 143
emulation probe, 135
LAN communication, 31
serial communication, 38
target system, 128

specifications, 147
SRESET signal, 64, 65, 66, 67
SRR1 register, 133
stand-alone logic analyzer, 157
StarLAN, 21, 29, 148
status lights, 121, 135

emulation module, 124
status, emulation probe/module, 

127
STOP LED, 122
subnet mask, 21, 32, 33
SunOS operating system, 21
supplied equipment, 16, 46
supplied software, 16, 46
SW watchdog, 132
switches

definitions, 23
LAN configuration, 23, 28
serial configuration, 34

SYPCR register, 67, 133
System Admin icon, 55

T

target control port, 157
target interface module (TIM), 2, 

16, 46, 65, 67, 157
target system

connection, 63, 69
problems, solving, 128
requirements, 64
reset status, 127
TCK_DSCK signal, 65, 66, 67
TCP service ports, 22
TDI_DSDI signal, 65, 66, 67
TDO_DSDO signal, 65, 66, 67
telnet, 29, 31, 40, 79, 125

port numbers, 60
temperature, 149
Terminal (MS Windows program), 

38
Terminal application in MS 

Windows 3.1, 36
terminal emulator, 23, 36, 40
terminal interface, 21, 23, 29, 40, 

77, 79
commands, 125
LAN parameters, setting, 23

test by running a program, 87
test memory accesses, 87
test the emulation module, 53
testing the target system, 133
testing with the target system, 87
ThinLAN, 21, 148
TIM

See target interface module

Torx screwdriver, 46
transition board, 157
Trigger In BNC, 85
TRIGGER OUT, 148
Trigger Out BNC, 85
trigger specification, 157
troubleshooting guide, 119
TX LED, 123

U

unknown state status, 127
updating firmware

emulation module, 56
emulation probe, 40

USER LED, 139, 144
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V

ver, terminal interface command, 
40, 126

versions, firmware
emulation module, 56
emulation probe, 40

VFLS0 signal, 65
VFLS0/FRZ signal, 65
VFLS0_MPIO32B3 signal, 65
VFLS1 signal, 65
VFLS1/FRZ signal, 65
VFLS1_MPGIO32B4 signal, 65
Vod signal, 65, 66, 67

W

watchpoint pins, 66
web site, 4, 40
wizard

See Setup Assistant

Workspace window, 56
workstation, serial connections, 34

X

X Windows server software, 90, 93
XRAY HP Probe, 103
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DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name: Hewlett-Packard Company

Manufacturer’s Address: Colorado Springs Division
1900 Garden of the Gods Road
Colorado Springs, CO 80907 U.S.A.

declares, that the product

Product Name: Emulation Probe

Model Number(s): HP E3456A

Product Option(s): All

conforms to the following Product Specifications:

Safety: IEC 1010-1:1990+A1 / EN 61010-1:1993
UL3111
CSA-C22.2 No. 1010.1:1993

EMC: CISPR 11:1990 / EN 55011:1991 Group 1 Class A
IEC 555-2:1982 + A1:1985 / EN 60555-2:1987
IEC 555-3:1982 + A1:1990 / EN 60555-3:1987 + A1:1991
IEC 801-2:1991 / EN 50082-1:1992 4 kV CD, 8 kV AD
IEC 801-3:1984 / EN 50082-1:1992 3 V/m, {1kHz 80% AM, 27-1000 MHz}
IEC 801-4:1998 / EN 50082-1:1992 0.5 kV Sig. Lines, 1 kV Power Lines

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC 
Directive 89/336/EEC and carries the CE marking accordingly.

This product was tested in a typical configuration with Hewlett-Packard test systems.

Colorado Springs, 03/22/97
John Strathman, Quality Manager

European Contact: Your local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department ZQ / Standards 
Europe, Herrenberger Strasse 130, D-71034 Böblingen Germany (FAX: +49-7031-14-3143)



Product Regulations

Safety IEC 1010-1:1990+A1 / EN 61010-1:1993
UL3111
CSA-C22.2 No. 1010.1:1993

EMC This Product meets the requirement of the European Communities (EC) EMC 
Directive 89/336/EEC.

Emissions EN55011/CISPR 11 (ISM, Group 1, Class A equipment)

Immunity EN50082-1 Code1 Notes2

IEC 801-2 (ESD) 8kV AD
IEC 801-3 (Rad.) 3 V/m
IEC 801-4 (EFT) 1kV

1
1
1

1

1Performance Codes:
1 PASS - Normal operation, no effect.
2 PASS - Temporary degradation, self recoverable.
3 PASS - Temporary degradation, operator intervention required.
4 FAIL - Not recoverable, component damage.

2Notes:
1. The target cable assembly is sensitive to ESD events. Use Standard ESD 
preventative practices to avoid component damage.

Sound Pressure 
Level

N/A



© Copyright Hewlett-Packard 
Company 1994-8
All Rights Reserved.

Reproduction, adaptation, or 
translation without prior written 
permission is prohibited, except 
as allowed under the copyright 
laws.

Restricted Rights Legend

Use, duplication, or disclosure by 
the U.S. Government is subject to 
restrictions set forth in 
subparagraph (C) (1) (ii) of the 
Rights in Technical Data and 
Computer Software Clause in 
DFARS 252.227-7013.  Hewlett-
Packard Company, 3000 Hanover 
Street, Palo Alto, CA 94304 U.S.A.  
Rights for non-DOD U.S. 
Government Departments and 
Agencies are set forth in FAR 
52.227-19 (c) (1,2).

Document Warranty

The information contained in this 
document is subject to change 
without notice.

Hewlett-Packard makes no 

warranty of any kind with 

regard to this material, 

including, but not limited to, 

the implied warranties of 

merchantability or fitness for 

a particular purpose.

Hewlett-Packard shall not be 
liable for errors contained herein 
or for damages in connection with 
the furnishing, performance, or 
use of this material.
Hewlett-Packard
P.O. Box 2197
1900 Garden of the Gods Ro
Colorado Springs, CO 80901
Safety

This apparatus has been designed 
and tested in accordance with 
IEC Publication 1010, Safety 
Requirements for Measuring 
Apparatus, and has been supplied 
in a safe condition.  This is a 
Safety Class I instrument 
(provided with terminal for 
protective earthing).  Before 
applying power, verify that the 
correct safety precautions are 
taken (see the following 
warnings).  In addition, note the 
external markings on the 
instrument that are described 
under "Safety Symbols."

Warning

• Before turning on the 
instrument, you must connect the 
protective earth terminal of the 
instrument to the protective 
conductor of the (mains) power 
cord. The mains plug shall only be 
inserted in a socket outlet 
provided with a protective earth 
contact. You must not negate the 
protective action by using an 
extension cord (power cable) 
without a protective conductor 
(grounding).  Grounding one 
conductor of a two-conductor 
outlet is not sufficient protection.

• Only fuses with the required 
rated current, voltage, and 
specified type (normal blow, time 
delay, etc.) should be used.  Do 
not use repaired fuses or short-
circuited fuseholders.  To do so 
could cause a shock of fire hazard.
ad
-2197, U.S.A.
• Service instructions are for 
trained service personnel. To 
avoid dangerous electric shock, 
do not perform any service unless 
qualified to do so.  Do not attempt 
internal service or adjustment 
unless another person, capable of 
rendering first aid and 
resuscitation, is present.

• If you energize this instrument 
by an auto transformer (for 
voltage reduction), make sure the 
common terminal is connected to 
the earth terminal of the power 
source.

• Whenever it is likely that the 
ground protection is impaired, 
you must make the instrument 
inoperative and secure it against 
any unintended operation.

• Do not operate the instrument 
in the presence of flammable 
gasses or fumes.  Operation of any 
electrical instrument in such an 
environment constitutes a definite 
safety hazard.

• Do not install substitute parts or 
perform any unauthorized 
modification to the instrument.

• Capacitors inside the 
instrument may retain a charge 
even if the instrument is 
disconnected from its source of 
supply.
Safety Symbols

Instruction manual symbol:  the 
product is marked with this 
symbol when it is necessary for 
you to refer to the instruction 
manual in order to protect against 
damage to the product.

Hazardous voltage symbol.

Earth terminal symbol: Used to 
indicate a circuit common 
connected to grounded chassis.

WARNING

The Warning sign denotes a 
hazard.  It calls attention to a 
procedure, practice, or the like, 
which, if not correctly performed 
or adhered to, could result in 
personal injury.  Do not proceed 
beyond a Warning sign until the 
indicated conditions are fully 
understood and met.

CAUTION

The Caution sign denotes a 
hazard.  It calls attention to an 
operating procedure, practice, or 
the like, which, if not correctly 
performed or adhered to, could 
result in damage to or destruction 
of part or all of the product.  Do 
not proceed beyond a Caution 
symbol until the indicated 
conditions are fully understood or 
met.

!



Product Warranty

This Hewlett-Packard product 
has a warranty against defects in 
material and workmanship for a 
period of one year from date of 
shipment.  During the warranty 
period, Hewlett- Packard 
Company will, at its option, either 
repair or replace products that 
prove to be defective.

For warranty service or repair, 
this product must be returned to 
a service facility designated by 
Hewlett- Packard.

For products returned to Hewlett-
Packard for warranty service, the 
Buyer shall prepay shipping 
charges to Hewlett- Packard and 
Hewlett-Packard shall pay 
shipping charges to return the 
product to the Buyer.  However, 
the Buyer shall pay all shipping 
charges, duties, and taxes for 
products returned to Hewlett-
Packard from another country.

Hewlett-Packard warrants that its 
software and firmware designated 
by Hewlett-Packard for use with 
an instrument will execute its 
programming instructions when 
properly installed on that 
instrument.  Hewlett-Packard 
does not warrant that the 
operation of the instrument 
software, or firmware will be 
uninterrupted or error free.

Limitation of Warranty

The foregoing warranty shall not 
apply to defects resulting from 
improper or inadequate 
maintenance by the Buyer, 
Buyer- supplied software or 
interfacing, unauthorized 
modification or misuse, operation 
outside of the environmental 
specifications for the product, or 
improper site preparation or 
maintenance.
No other warranty is 

expressed or implied.  

Hewlett-Packard specifically 

disclaims the implied 

warranties of merchantability 

or fitness for a particular 

purpose.

Exclusive Remedies

The remedies provided herein are 
the buyer’s sole and exclusive 
remedies.  Hewlett-Packard shall 
not be liable for any direct, 
indirect, special, incidental, or 
consequential damages, whether 
based on contract, tort, or any 
other legal theory.

Assistance

Product maintenance agreements 
and other customer assistance 
agreements are available for 
Hewlett-Packard products. For 
any assistance, contact your 
nearest Hewlett-Packard Sales 
Office.

Certification

Hewlett-Packard Company 
certifies that this product met its 
published specifications at the 
time of shipment from the factory.  
Hewlett-Packard further certifies 
that its calibration measurements 
are traceable to the United States 
National Institute of Standards 
and Technology, to the extent 
allowed by the Institute’s 
calibration facility, and to the 
calibration facilities of other 
International Standards 
Organization members.
About this edition

This is the Emulation for the 

PowerPC MPC500 User’s 

Guide.

Publication number
E3456-97002, July 1998
Printed in USA.

Print history is as follows:
First edition, July 1998

New editions are complete 
revisions of the manual.  Many 
product updates do not require 
manual changes, and manual 
corrections may be done without 
accompanying product changes. 
Therefore, do not expect a one-
to-one correspondence between 
product updates and manual 
updates.
UNIX is a registered trademark in 
the United States and other 
countries, licensed exclusively 
through X/Open Company 
Limited.

MPC500 Embedded PowerPC 
microprocessors are products of 
Motorola, Inc.
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